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Περίληψη 
 

Η διαδικασία της προσομοίωσης έχει ως στόχο τη μελέτη και την κατανόηση ενός 

συστήματος αλλά και τον πειραματισμό πάνω στο σύστημα αυτό με πολλά και 

διαφορετικά σενάρια. Οι χρήστες χειρίζονται τα συστατικά του συστήματος με πλήρως 

αλληλεπιδραστικό τρόπο, όπως είναι για παράδειγμα η προσομοίωση χειρισμού ενός 

πολεμικού αεροπλάνου. 

Οι προσομοιώσεις χρησιμοποιούνται σε πολλά επιστημονικά πεδία και βοηθούν στην 

κατανόηση και τη μελέτη πολλών φυσικών, βιολογικών και κοινωνικών συστημάτων. 

Μάλιστα, αποτελούν τον πλέον διαδεδομένο αλλά και αποτελεσματικό τρόπο των 

τεχνολογιών πληροφορικής στην εκπαιδευτική διαδικασία. 

Η παρούσα πτυχιακή κάνει μία ανασκόπηση των προγραμμάτων προσομοίωσης που 

χρησιμοποιούνται στο χώρο των ηλεκτρονικών κυκλωμάτων. Ειδικότερα, αναλύει και 

περιγράφει τα χαρακτηριστικά αυτών δίνονταν βάση στις εξειδικευμένες λειτουργίες τους 

και στα πεδία της εφαρμογής τους.  

 

 

Λέξεις κλειδιά  

Προσομοίωση, αναλογικό κύκλωμα, ψηφιακό κύκλωμα, λογισμικό 
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Abstract 
 

Every simulation has as main purpose to study and understand a system and 

furthermore experiment this system with the use of many different scenarios.  

The simulations are used in many scientific fields and assist in understanding 

and study of many physical, biological and social systems. Indeed, they are 

the most common and effective way of IT technologies in the educational 

process. 

This thesis makes a review of the simulation programs used in the field of 

electronics. In particular, it analyzes and describes the characteristics of these 

were given based on their specific functions and fields of application. 

 

 

 

 

 

Keywords 

Simulation, analog circuit, digital circuit, software  
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Κεφάλαιο 1 

 

1.1 Εισαγωγή 

 

Ο όρος προσομοίωση αφορά τη μίμηση της λειτουργίας ενός συστήματος που υπάρχει ήδη 

στον πραγματικό κόσμο, με τη βοήθεια υπολογιστή (School.gr, 2016). Η πράξη της 

προσομοίωσης για να πραγματοποιηθεί απαιτεί την ανάπτυξη ενός μοντέλου. Αυτό το 

μοντέλο εκπροσωπεί το κλειδί, τα χαρακτηριστικά ή τις συμπεριφορές ενός αφηρημένου 

συστήματος ή διαδικασίας. Το μοντέλο αντιπροσωπεύει το ίδιο το σύστημα ενώ η 

προσομοίωση παριστάνει τη λειτουργία του συστήματος (School.gr, 2016). 

 

 

Λόγω της δυνατότητας της μίμησης, η προσομοίωση χρησιμοποιείται κατά κόρον στο 

χώρο της πληροφορικής. Ουσιαστικά, αποτελεί μία από τις μεθόδους μελέτης ενός 

συστήματος, με τη βοήθεια ενός άλλου συστήματος που στην περίπτωση αυτή είναι ο 

υπολογιστής. Πρόκειται λοιπόν για μία αναπαράσταση ή ένα μοντέλο, φτιαγμένο με τρόπο 

τέτοιο ώστε να βοηθήσει σημαντικά στην κατανόηση της λειτουργίας ενός ολόκληρου 

συστήματος. Το σύστημα προσομοίωσης «μιμείται» τη συμπεριφορά αυτού που 
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αναπαριστά και συνεπώς επιτρέπει εξοικείωση με τα χαρακτηριστικά του και κατανόηση 

των λειτουργιών του.  

Στόχος κάθε συστήματος προσομοίωσης είναι φυσικά η μελέτη και η κατανόηση ενός 

άλλου συστήματος αλλά και ο πειραματισμός πάνω στο υπό μελέτη σύστημα με πολλά και 

διαφορετικά σενάρια. Οι χρήστες χειρίζονται τα συστατικά του συστήματος με πλήρως 

αλληλεπιδραστικό τρόπο, όπως είναι για παράδειγμα η προσομοίωση χειρισμού ενός 

πολεμικού αεροπλάνου. 

Οι προσομοιώσεις χρησιμοποιούνται σε πολλά επιστημονικά πεδία και βοηθούν στην 

κατανόηση και τη μελέτη πολλών φυσικών, βιολογικών και κοινωνικών συστημάτων. 

Μάλιστα, αποτελούν τον πλέον διαδεδομένο αλλά και αποτελεσματικό τρόπο των 

τεχνολογιών πληροφορικής στην εκπαιδευτική διαδικασία (Banks, Karson, Nelson, & 

Nicol, 2000). Κατά την εκπαιδευτική προσομοίωση, οι χρήστες μπορούν να μελετούν ένα 

φαινόμενο, ένα σύστημα ή κάποια δραστηριότητα, κατά βούληση αλλάζοντας απλά τις 

μεταβλητές χρήσης.  

Η προσομοίωση διακρίνεται στους δύο παρακάτω τύπους (Ρουμελιώτης, 2011) : 

1. Αυτές που προσομοιώνουν κάτι 

a. Φυσική προσομοίωση, στην οποία ένα φυσικό φαινόμενο ή κατάσταση 

αναπαρίσταται από το υπολογιστικό σύστημα στην οθόνη επιτρέποντας 

στον χρήστη να μάθει κάτι για αυτό όταν χειρίζεται κάποια ή κάποιες 

μεταβλητές 

b. Επαναληπτική προσομοίωση, στην οποία ο χρήστης εκτελεί διαδοχικές 

φορές την προσομοίωση επιλέγοντας τιμές για τις διάφορες παραμέτρους 

2. Αυτές που δείχνουν πώς να γίνει κάτι 

a. Διαδικαστική προσομοίωση, η οποία στοχεύει να διδάξει μια αλληλουχία 

ενεργειών για την επίτευξη κάποιου στόχου  

b. Προσομοίωση κατάστασης, κατά την οποία ο χρήστης εξερευνά 

εναλλακτικές διαδρομές σε ένα σύστημα για να μελετήσει τις επιπτώσεις 

τους. 
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1.2 Η αναγκαιότητα της χρήσης των προσομοιωτών  

 

Η προσομοίωση, ως διδακτική στρατηγική μπορεί να χρησιμοποιηθεί με τρεις 

διαφορετικούς τρόπους στην πρωτοβάθμια εκπαίδευση (Ρουμελιώτης, 2011): 

 Υποστήριξη του μαθήματος με τη βοήθεια αλληλεπιδραστικής προσομοίωσης 

(διδασκαλία από τον εκπαιδευτικό που χρησιμοποιεί την προσομοίωση ως 

εποπτικό μέσο), 

 Επαλήθευση ενός μοντέλου (χρήση προσομοίωσης από τον μαθητή και 

αλληλεπίδραση με τον εκπαιδευτικό για συμπληρωματική ανατροφοδότηση), 

 Κλασσική αλληλεπιδραστική προσομοίωση (ατομική ή συλλογική χρήση ενός 

μοντέλου από μαθητές). 

 

Κάθε εκπαιδευτικό λογισμικό κατασκευάζεται με βάση το μοντέλο το οποίο θέλει να 

μελετήσει ακολουθώντας τις δύο παρακάτω σχεδιαστικές προδιαγραφές  (Ρουμελιώτης, 

2011):  

Α) Το μοντέλο είναι άγνωστο στο μαθητή. Τότε η προσομοίωση αποκαλείται 

μοντελοποιητική (modeling) και ο στόχος της χρήσης του συστήματος από τους μαθητές 

είναι να ανακαλύψουν το υποκείμενο μοντέλο μέσα από διαδικασίες διερευνητικής 

μάθησης. 

Β) Το μοντέλο είναι γνωστό στο μαθητή. Τότε η προσομοίωση αποκαλείται 

συμπεριφοριστική (behaviorist) και διακρίνεται σε τρεις κατηγορίες :  

i. Τη δυναμική προσομοίωση επικεντρωμένη στη μελέτη της επιρροής 

των παραμέτρων, 

ii. Τη μεθοδολογική προσομοίωση της οποίας στόχος δεν είναι η 

μελέτη των συνεπειών ενός μοντέλου κάνοντας να μεταβληθούν οι 

παράμετροί του, αλλά η αντιπαράθεσή του με την εμπειρία ή με την 

κοινή λογική 

iii. Την επιχειρησιακή προσομοίωση που στοχεύει να θέσει σε 

λειτουργία ένα πείραμα ή μια συσκευή μαθαίνοντας έτσι τις 

διαδικασίες, τα μοντέλα και τα συστήματα 
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Κάθε εφαρμογή προσομοίωσης λοιπόν διέπεται από τις παρακάτω προδιαγραφές (Banks, 

1998) :  

 Μια εκπαιδευτική προσομοίωση πρέπει να χρησιμοποιεί χαμηλή 

πιστότητα του αντικειμένου της προσομοίωσης για αρχάριους 

μαθητές και υψηλή πιστότητα του αντικειμένου της προσομοίωσης 

για προχωρημένους μαθητές 

 Μια εκπαιδευτική προσομοίωση, εκτός των οπτικών 

αναπαραστάσεων που προσιδιάζουν στο προς αναπαράσταση 

φαινόμενο, πρέπει να περιέχει και εναλλακτικού τύπου 

αναπαραστάσεις, όπως πίνακες τιμών, γραφικές παραστάσεις, κλπ. 

 Μια εκπαιδευτική προσομοίωση πρέπει να προσφέρει ποικίλες 

μορφές ανάδρασης ανάλογα με το είδος της (κειμένου, εικόνων, 

πραγματική, πιθανοτική) και αμεσότητα ανάδρασης 

 Μια εκπαιδευτική φυσική προσομοίωση πρέπει να περιέχει ικανό 

πλήθος αντικειμένων, να προσφέρει σχέσεις αιτίου – αιτιατού, με 

σχετική λεπτομέρεια και ρεαλισμό παρουσίασης 

 Μια εκπαιδευτική φυσική προσομοίωση πρέπει να προσφέρει τον 

έλεγχο στον χρήστη ώστε να ρυθμίζει ο ίδιος τη φυσική εξέλιξη του 

προς μελέτη φαινομένου 

 Σε μια εκπαιδευτική επαναληπτική προσομοίωση πρέπει να υπάρχει 

ακρίβεια μεταβλητών στο κύριο μοντέλο και να είναι ξεκάθαρο 

ποιες μεταβλητές είναι άγνωστες, ποιες γνωστές αλλά όχι 

διαχειρίσιμες και ποιες γνωστές και διαχειρίσιμες 

 Σε μια εκπαιδευτική επαναληπτική προσομοίωση πρέπει να είναι 

δυνατός ο καθορισμός αρχικών μεταβλητών και να υπάρχει υψηλό 

επίπεδο ελέγχου από τον χρήστη ανάμεσα στις επαναλήψεις της 

προσομοίωσης 

 Σε μια εκπαιδευτική διαδικαστική προσομοίωση πρέπει να υπάρχει 

πλήθος δυνατών διαδρομών λύσης και πλήθος πιθανών ενεργειών 

Τα πλεονεκτήματα των εκπαιδευτικών προσομοιώσεων συνοψίζονται παρακάτω (Banks, 

1998) :  

• Μπορεί να αποτελεί την μόνη προσέγγιση για την επίλυση κάποιων προβλημάτων (π.χ. 

μελέτη λειτουργίας ενός απροσπέλαστου συστήματος) 
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• Μπορεί να κοστίζει λιγότερο από το χειρισμό του πραγματικού συστήματος 

• Παρουσιάζει μεγαλύτερη ευαισθησία στην αντίληψη των σχέσεων μεταξύ των 

προβλημάτων (αφού οι μεταβλητές που μπορούμε να χειριστούμε είναι εμφανείς και 

προσπελάσιμες από τους χρήστες της προσομοίωσης) 

• Είναι ασφαλής μέθοδος (π.χ. χειρισμός αεροπλάνου) σε αντίθεση με πολλά από τα 

πραγματικά πειράματα 

• Δίνει τη δυνατότητα επανάληψης του ιδίου φαινομένου κατά βούληση 

• Δίνει τη δυνατότητα πλήρους ενόρασης του συστήματος που εξετάζεται από όλες τις 

πλευρές 

Από την άλλη, τα μειονεκτήματα αυτής είναι : 

• Κάποιες φορές απαιτεί σημαντικό χρόνο ανάπτυξης και μεγάλο κόστος 

• Μπορεί να μην είναι η πιο κατάλληλη μέθοδος επίλυσης του μελετούμενου προβλήματος 

• Δεν εγγυάται ότι θα οδηγήσει στην καλύτερη δυνατή λύση 

• Μπορεί να μην αντανακλά με ακρίβεια την υπό μελέτη κατάσταση 

• Σε μια προσομοίωση το μοντέλο που την διέπει έχει ήδη δημιουργηθεί από κάποιον άλλο 

• Οδηγεί στην ανάγκη για περιβάλλοντα που επιτρέπουν τη δημιουργία μοντέλων 

 

1.3 Κατηγορίες προσομοιωτών 

 

1.3.1 Προσομοιωτές κυκλωμάτων 

 

Οι προσομοιωτές των κυκλωμάτων αποτελούν τα προγράμματα εκείνα που έχουν ως 

στόχο να αναπαράγουν τη λειτουργία μιας συσκευής ή ενός κυκλώματος. Η αναπαραγωγή 

της συμπεριφοράς της συσκευής ή του συστήματος συνίσταται στην παραγωγή των 

σημάτων εξόδου ή/και στην παραγωγή δεδομένων που αφορούν τις επιδόσεις της 

συσκευής ή του συστήματος υπό προσομοίωση για δεδομένες τιμές των σημάτων εισόδου.  

Η χρήση των προσομοιωτών στο πεδίο των κυκλωμάτων εισάγει τα παρακάτω 

πλεονεκτήματα (Banks, 1998) : 
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 Επιτρέπει την αξιολόγηση πολλών εναλλακτικών σχεδιασμών Hardware χωρίς να 

είναι απαραίτητη η κατασκευή τους η οποία μάλιστα πολλές φορές αποτελεί μία 

ιδιαίτερα χρονοβόρα και υψηλού κόστους διαδικασία 

 Καθιστά δυνατή τη χρήση και την αξιολόγηση των συστημάτων τα οποία δεν 

υπάρχουν στην πράξη 

 Δίνει τη δυνατότητα να συλλεχθούν πολλαπλά δεδομένα που αφορούν τις 

επιδόσεις του συστήματος με μία και μόνο εκτέλεση 

Οι προσομοιωτές μπορούν να διαχωριστούν στους λειτουργικούς προσομοιωτές και στους 

προσομοιωτές επιδόσεων. Οι λειτουργικοί προσομοιωτές επιτελούν τη λειτουργία της 

απλός προσομοίωσης ενός μέρους του συστήματος στον υπολογιστή και έτσι δεν μπορούν 

να παρέχουν εκτιμήσεις για τις επιδόσεις του συστήματος (Banks, 1998). Από την άλλη, οι 

προσομοιωτές επιδόσεων προσομοιώνουν στο μέγιστο δυνατό βαθμό τις επιδόσεις του 

συστήματος. Σημαντικό πλεονέκτημα της κατηγορίας αυτής των προσομοιωτών αποτελεί 

το γεγονός ότι η δυνατότητα εκτέλεσης οποιουδήποτε προγράμματος εντός του 

προσομοιωτή αρκεί να έχει μεταγλωττιστεί για τη συγκεκριμένη αρχιτεκτονική συνόλου 

εντολών που προσομοιώνει ο προσομοιωτής.  

Οι προσομοιωτές επιδόσεων χωρίζονται σε δύο κατηγορίες, σε αυτούς που 

προσομοιώνουν επακριβώς τη λειτουργία του κυκλώματος για κάθε κύκλο ρολογιού και 

σε αυτούς που απλά προγραμματίζουν την εκτέλεση των διαφόρων εντολών (Banks, 

Karson, Nelson, & Nicol, 2000). Στην πρώτη κατηγορία, διατηρούνται ανά πάσα στιγμή τα 

δεδομένα για την κατάσταση όλων των μερών του κυκλώματος ενώ στη δεύτερη 

διατηρούνται απλά πληροφορίες σχετικές με την διαθεσιμότητα του κυκλώματος.  

 

1.3.2 Προσομοιωτές δικτύων 

 

Οι προσομοιωτές δικτύων, αφορούν αποκλειστικά και μόνο στην προσομοίωση την 

δικτύων υπολογιστών είτε αυτά είναι ενσύρματα, είτε ασύρματα, είτε μικτά. Ένας πρώτος 

διαχωρισμός αυτών αφορά στο εάν αυτοί είναι ανοικτού ή κλειστού κώδικα (εμπορικοί). 

Κάποιοι από αυτούς λοιπόν αποτελούν καθαρά εμπορικά πακέτα, γεγονός που σημαίνει 

ότι δεν παρέχεται καμία πληροφορία για τον πηγαίο τους κώδικα και ότι δεν μπορεί να 

γίνει καμία τροποποίηση σε αυτούς (Γεωργόπουλος, 2011). Οι χρήστες του προγράμματος 

πρέπει να καταβάλλουν το αντίτιμο για την άδεια χρήσης του λογισμικού ή να πληρώσουν 
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προκειμένου να χρησιμοποιήσουν ειδικά πακέτα που απαιτούνται για να ικανοποιήσουν 

τις ιδιαίτερες ανάγκες τους. Ένα χαρακτηριστικό παράδειγμα είναι το OPNET.  

Ένα τέτοιο πακέτο λογισμικού, φυσικά χαρακτηρίζεται τόσο από πλεονεκτήματα όσο και 

από μειονεκτήματα. Στα πλεονεκτήματά του συγκαταλέγονται οι πλήρεις και 

ενημερωμένες τεκμηριώσεις μετρήσεων και η συχνή ενημέρωσή τους. Ως μειονέκτημα 

χαρακτηρίζεται αυτό το οποίο προαναφέρθηκε, το γεγονός δηλαδή ότι δεν μπορεί ο 

χρήστης να παρέμβει στον κώδικα (Γεωργόπουλος, 2011).  

Τα ανοικτά λογισμικά από την άλλη, υστερούν σε ότι αφορά το υψηλό επίπεδο των 

προσομοιώσεων καθώς δεν υπάρχουν αρκετά και εξειδικευμένα άτομα που θα μπορούσαν 

να τα υποστηρίξουν. Το πρόβλημα αυτό μπορεί να είναι ιδιαιτέρως σοβαρό όταν οι 

διάφορες εκδόσεις έρχονται με πολλά νέα χαρακτηριστικά ή αλλαγές και καθιστούν 

δύσκολο στον χρήστη να αντιληφθεί τα νέα χαρακτηριστικά και τις τροποποιημένες 

λειτουργίες χωρίς την ύπαρξη κατάλληλης τεκμηρίωσης (Γεωργόπουλος, 2011). Αντίθετα, 

τα ανοικτά λογισμικά προσομοίωσης δικτύου διαθέτουν το συγκριτικό πλεονέκτημα ότι 

είναι εξαιρετικά ανοιχτά στο σύνολό τους, έτσι ώστε ο κάθε απλός χρήστης μεμονωμένα ή 

ένας οργανισμός να έχει τη δυνατότητα να συμβάλει ενεργά στην ανάπτυξή τους. 

Ένας ακόμη διαχωρισμός που θα μπορούσε να γίνει στους προσομοιωτές δικτύου αφορά 

στο πόσο απλοί ή πόσο σύνθετοι είναι αυτοί. Στους σύνθετους προσομοιωτές ο χρήστης 

έχει τη δυνατότητα να καθορίσει όλες τις παραμέτρους από τα πρωτόκολλα που 

χρησιμοποιούνται για την επεξεργασία της δικτυακής κίνησης. Παρόλα αυτά υπάρχουν 

και προσομοιωτές με λιγότερο έξυπνο περιβάλλον εργασίας. Αυτοί ανήκουν στην 

κατηγορία των απλών 

 

1.3.3 Προσομοιωτές για τη διαχείριση της εναέριας κυκλοφορίας 

 

Η διαχείριση της εναέριας κυκλοφορίας αφορά στην ασφάλεια των πτήσεων και για το 

λόγο αυτό είναι ιδιαίτερα σημαντική. Οι προσομοιωτές στην εναέρια κυκλοφορία, 

λειτουργούν με προγράμματα προσομοίωσης, εργαλεία με τα οποία επίσης δοκιμάζονται 

και βελτιστοποιούνται σε στοιχεία όπως η πλοκή των αεροδιαδρόμων, οι διαδικασίες 

προσγείωσης και απογείωσης και οι εφαρμοζόμενες συνεργασίες μεταξύ εμπλεκομένων 

υπηρεσιών (Ανδρεαδάκης, 2002). Σπουδαία και αποτελεσματική είναι επίσης η προσφορά 
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των εργαλείων αυτών στην εξοικείωση των ελεγκτών εναέριας κυκλοφορίας και σε 

καινούργιες μεθόδους διαχείρισης της εναέριας κυκλοφορίας.  

Στα είδη των προσομοιωτών που διακρίνονται στην κατηγορία αυτή ανήκουν οι 

προσομοιωτές ελέγχου με Radar, οι προσομοιωτές διαδικασιακού ελέγχου και οι 

προσομοιωτές για τον έλεγχο του αεροδρομίου.  

Η αρχιτεκτονική ενός συστήματος προσομοίωσης ενδεχόμενα να περιλαμβάνει θέσεις 

εργασίας για ελεγκτή διαδικασιακού ελέγχου, ελεγκτή Radar, ελεγκτή πύργου 

αεροδρομίου με οθόνη τριών διαστάσεων (3D), ελεγκτή πύργου αεροδρομίου με οθόνη 

δύο διαστάσεων (2D) και θέση εργασίας για πιλότο (Ανδρεαδάκης, 2002). Οι παραπάνω 

θέσεις εργασίας, είναι εξοπλισμένες με συστήματα ηλεκτρονικών υπολογιστών. Μάλιστα, 

η κονσόλα κάθε πιλότου, φέρει οθόνη στην οποία αυτός παρακολουθεί την εναέρια 

κυκλοφορία μιας συγκεκριμένης άσκησης. Η κονσόλα κάθε ελεγκτού διαθέτει μία οθόνη, 

την οθόνη Radar εάν πρόκειται για προσομοιωτή ελέγχου με Radar (Ανδρεαδάκης, 2002). 

Στον προσομοιωτή ελέγχου χωρίς την χρήση Radar δηλαδή στον προσομοιωτή 

διαδικασιακού ελέγχου, ο ελεγκτής αντί της οθόνης έχει στην διάθεση του χάρτινες 

λωρίδες προόδου πτήσεως, τα λεγόμενα paper strips, με τυπωμένα τα στοιχεία κάθε 

πτήσης και στα οποία σημειώνει τις οδηγίες που δίνει στα αεροσκάφη, δηλαδή στον 

αντίστοιχο πιλότο.  

Τέλος στον προσομοιωτή ελέγχου αεροδρομίου, ο ελεγκτής περιβάλλεται από μεγάλες 

οθόνες μέχρι και σε πλήρη κύκλο (3600 ) στις οποίες παρακολουθεί με τρισδιάστατη 

εικόνα (3D) την κυκλοφορία του αεροδρομίου όπως ακριβώς και στην πραγματικότητα 

κάνει, εργαζόμενος στον πύργο ελέγχου. Και σ’ αυτή την περίπτωση επικοινωνεί με 

πιλότο, ο οποίος υποδύεται όλους του κυβερνήτες των πτήσεων μιας άσκησης. Στην τρίτη 

αυτή περίπτωση προσομοιωτή ελέγχου αεροδρομίου, υπάρχει η δυνατότητα ο ελεγκτής να 

έχει στην διάθεση του και οθόνη με εικόνα δύο διαστάσεων (2D), στην οποία να 

παρακολουθεί τα αεροσκάφη που τροχοδρομούν (Ανδρεαδάκης, 2002).  
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Κεφάλαιο 2  

 

2.1  Παραδείγματα προσομοιωτών 

 

2.1.1 To CircuitLogix 

 

To πολύ γνωστό αυτό λογισμικό αναπτύχθηκε στο πανεπιστήμιο George Brown College 

στον Καναδά, σε συνεργασία πάντα με την εταιρία Logic Design Inc, από τον καθηγητή 

ηλεκτρονικής Collin Simpson (Circuit, 2006). Πρόκειται για ένα λογισμικό προσομοίωσης 

κυκλωμάτων που κάνει χρήση του Pspice σε ότι αφορά στην προσομοίωση χιλιάδων 

ηλεκτρονικών συσκευών, μοντέλων και κυκλωμάτων.  Το CircuitLogix υποστηρίζει την 

προσομοίωση αναλογικών, ψηφιακών αλλά και μεικτών κυκλωμάτων ενώ ακριβώς επειδή 

κάνει χρήση του Spice παρέχει τη δυνατότητα διεξαγωγής ακριβών αποτελεσμάτων 

πραγματικού χρόνου (Circuit, 2006).  

Πρόκειται για ένα ιδιαίτερα εύχρηστο λογισμικό, με ένα γραφικό περιβάλλον τέτοιο, που 

να επιτρέπει στους χρήστης να σχεδιάζουν, να τροποποιούν αλλά και να συνδυάζουν σειρά 

κυκλωμάτων. Μάλιστα, η επαγγελματική έκδοση αυτού διαθέτει μία βιβλιοθήκη 10.000 

συσκευών που καθιστά ιδιαίτερα χρήσιμα και αποδοτικά τα αποτελέσματα που εξάγονται.  

Τα βασικά εργαλεία τα οποία χρησιμοποιεί είναι  (Circuit, 2006):  

 Εξαιρετικά εύχρηστο γραφικό περιβάλλον εργασίας χρήστη.  

 Ευέλικτη ονομασία κυκλώματος κόμβου.  

 Αυτόματη καλωδίωση σημείο-προς-σημείο.  

 Καλωδιακή σύνδεση η οποία διατηρείται κατά τη διάρκεια κίνησης.  

 PCB netlist εξαγωγής.  

 Συσκευή περιστροφής κατά 90 μοίρες.  

 Undo, Redo, συγχώνευση κυκλωμάτων, μεγέθυνση ή σμίκρυνση από 10% -1000%.  

 Ευρύ φάσμα χρωμάτων καθοριζόμενα από το χρήστη.  
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 Αλφαριθμητικό κωδικό ονομασιών pin, παραγράφονται ακίδες, κάθετη ή οριζόντια 

pin προσανατολισμού.  

 Επανατοποθέτηση του καλωδίου κάνοντας ένα κλικ.  

 Πολλαπλά καλώδια με το ίδιο pin της συσκευής.  

 Κοπή και επέκταση καλωδίων.  

 Οn-line βοήθεια  

 Δεξί κλικ στο αναδυόμενο μενού για γρήγορη πρόσβαση στα εργαλεία 

επεξεργασίας και τα χαρακτηριστικά. 

Πρόκειται για ένα ιδιαίτερα φιλικό στο χρήστη αλλά και πολύ καλά σχεδιασμένο 

λογισμικό το οποίο μπορεί να χρησιμοποιηθεί άμεσα και χωρίς ιδιαίτερος γνώσεις. Όπως 

προειπώθηκε, το λογισμικό αυτό μπορεί να προσομοιώσει αναλογικά και ψηφιακά 

κυκλώματα με εύκολο και γρήγορο τρόπο (Circuit, 2006). Ο χρήστης μπορεί να 

κατασκευάσει ιδιαίτερα εύκολα τα κυκλώματα που επιθυμεί με τη προϋπόθεση ότι κάθε 

φορά που αυτός θα «τρέχει» το πρόγραμμα θα το κάνει σε ψηφιακό mode. Διαφορετικά το 

πρόγραμμα θα εμφανίσει άμεσα ένα μήνυμα λάθους. Για να αποφύγει ο χρήστης το 

μήνυμα αυτό καλό θα είναι να κάνει διπλά κλικ στο εικονίδιο του μενού που φέρει το 

τρανζίστορ όπως ακριβώς φαίνεται στην παρακάτω εικόνα.  

 

 

Εικόνα 1 : Βασικό μενού (Circuit, 2006) 

 

Όπως κάθε λογισμικό, έτσι και το CircuitLogix περιέχει το μενού επιλογές στο οποίο ο 

χρήστης μπορεί να δει όλες τις διαθέσιμες επιλογές που προσφέρονται από το πρόγραμμα 

(Circuit, 2006). 
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Εικόνα 2 : Μενού επιλογές (Circuit, 2006) 

 

Με χρήση της βιβλιοθήκης συσκευές ο χρήστης είναι σε θέση να επιλέξει μια ή/και 

περισσότερες συσκευές ώστε να τις χρησιμοποιήσει στο κύκλωμά του (Circuit, 2006). 

Μάλιστα, η σύνδεση μεταξύ των συσκευών μπορεί να γίνει με ιδιαίτερα εύκολο τρόπο, 

κάνοντας χρήση απλά και μόνο του εργαλείου καλώδιο, το οποίο συνδέει εισόδους και 

εξόδους συσκευών. Η πλέον χρησιμοποιούμενη συσκευή εισόδου είναι ένας ψηφιακός 

διακόπτης ο οποίος εναλλάσσει τις τιμές ανάμεσα στο 0 και το 1 κάθε φορά που ο χρήστης 

κάνει κλικ επάνω του. Στην παρακάτω εικόνα εμφανίζεται το μενού εισαγωγής του 

(Circuit, 2006). 

Η προσομοίωση του κυκλώματος γίνεται με χρήση του διακόπτη On/Off. Όταν ο 

διακόπτης βρίσκεται στη θέση On η προσομοίωση είναι ενεργή και ο χρήστης είναι σε 

θέση να δει την τιμή που υπάρχει σε οποιαδήποτε θέση του κυκλώματός του με απλή 

χρήση ενός και μόνο εργαλείου το οποίο είναι εμφανές στην εικόνα που ακολουθεί. Οι 

τιμές που εμφανίζει το εργαλείο είναι H (υψηλή), L (χαμηλή) και Ζ (ενδιάμεση) σε όποιο 

σημείο και εάν επιδείξει ο χρήστης (Circuit, 2006).  
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Εικόνα 3 : Βασικό μενού (Circuit, 2006) 

Δεν είναι λίγες οι φορές εκείνες κατά τις οποίες ο χρήστης επιθυμεί να έχει οπτική 

διαφόρων μερών του κυκλώματος κατά τη διάρκεια της προσομοίωσης. Για να γίνει αυτό 

μπορεί να χρησιμοποιηθεί είτε το πλήκτρο F12 είτε το αντίστοιχο κουμπί που φέρει μία 

κυματομορφή στο βασικό μενού. Οι κυματομορφές παρουσιάζονται σε ένα ξεχωριστό 

παράθυρο ώστε ο χρήστης να είναι σε θέση να επιλέξει ποιο σημείο από αυτές θέλει να 

εμφανιστεί. Ο συνηθέστερος τρόπος για να γίνει αυτό είναι με χρήση του εργαλείου 

τηλεσκόπιο (Circuit, 2006).  

 

 

Εικόνα 4 : Εμφάνιση κυματομορφών 

 

Ο χρήστης μπορεί να μετακινήσει τις κυματομορφές προς τα πάνω ή προς τα κάνεις με 

απλή χρήση  drag and drop. Στα λευκά κουτάκια που εμφανίζονται αριστερά των 

κυματομορφών εμφανίζονται τα ονόματα των διαφορετικών σημείων που έχουν επιλεγεί 
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προς εμφάνιση. Τα σημεία αυτά παρέχουν τη δυνατότητα παύσης της προσομοίωσης όταν 

θα έχουν επιτευχθεί οι επιθυμητές συνθήκες (Circuit, 2006).  

 

 

Εικόνα 5 :Κυματομορφές (Circuit, 2006) 

 

Το CircuitLogic δίνει τη δυνατότητα παραγωγής αυτόματων τιμών εισόδου ή ακολουθίας 

ρολογιού οι οποίες παράγονται με χρήση του DataSequencer. Στην εικόνα που ακολουθεί 

παρουσιάζεται πως ο χρήστης μπορεί να ρυθμίσει το πρόγραμμα έτσι ώστε τα pin 1-3 του 

κυκλώματος να μπορούν να χρησιμοποιηθούν ως σήματα εισόδου.  
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Εικόνα 6 : Παράδειγμα χρήσης των pins 1-3 ως εισόδων (Circuit, 2006) 

 

Η χρήση του διπλού κλικ επάνω στο κύκλωμα οδηγεί στην εμφάνιση του μενού Edit 

DataSequencer το οποίο παράγει τις κατάλληλες τιμές για την προσομοίωση. Το 

DataSequencer έχει τη δυνατότητα παραγωγής έως και 8 διαφορετικών ψηφιακών 

σημάτων για 32 διαφορετικές ακολουθίες.  

O χρήστης έχει την δυνατότητα να επιλέξει και να χρησιμοποιήσει το μενού Digital 

Options ως να τροποποιήσει το βήμα που ακολουθείται κατά την εκτέλεση της 

προσομοίωσης, να ορίσει τις συνθήκες κάτω από τις οποίες θα γίνονται τα break points 

αλλά και να ορίσει την ταχύτητα της προσομοίωσης. Ακολουθώντας τα βήματα 

Simulation > Digital εμφανίζεται το κατάλληλο μενού. Στη συνέχει ορίζεται το μέγεθος 
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του βήματος είτε σε ticks είτε σε κύκλους (ένας κύκλος αποτελείται από 10 ticks). Το tick 

είναι η μικρότερη μονάδα της προσομοίωσης για την ψηφιακό εξομοιωτή. Έτσι απαιτείται 

τουλάχιστον ένα tick ώστε να ξεκινήσει η προσομοίωση για όλες τις συσκευές (Circuit, 

2006). 

Ακόμη, το μενού αυτό, δίνει τη δυνατότητα επιλογής προβολής ενός μικρού ή ενός 

μεγάλου μέρους των κυματομορφών. Αυτό γίνεται με την επιλογή magnification η οποία 

εξ ορισμού παίρνει την τιμή 8. Μία μεγαλύτερη από το 8 τιμή κάνει zoom in ενώ μία 

μικρότερη zoom out. To μενού simulation speed ελέγχει την ταχύτητα με την οποία 

διεξάγεται η προσομοίωση.  Θέτοντας μία τιμή μικρότερη της προκαθορισμένης, η 

προσομοίωση εκτελείται με αργότερο ρυθμό. Το παραπάνω μπορεί επίσης να επιτευχθεί 

κάνοντας χρήση ενός και μόνο mode βήματος.  

 

Εικόνα 7 : Μενού ψηφιακών επιλογών (Circuit, 2006) 

Οι επιλογές Breakpoint και Options, συνδυασμένες με τον παράθυρο των κυματομορφών 

καθορίζουν τα σημεία στα οποία θα τεθούν τα breakpoints. Στον πίνακα που ακολουθεί 

παρουσιάζονται τα αποτελέσματα που θα δημιουργηθούν όταν συνδυαστούν κάποιες από 

τις ρυθμίσεις.  

Συνδυασμός Αποτέλεσμα 

Level-And Ικανοποιούνται όλες οι συνθήκες και έπειτα 

τερματίζεται η προσομοίωση 

Level-Or Οποιαδήποτε συνθήκη και εάν ικανοποιηθεί 

σταματά την προσομοίωση 
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Edge-And Η προσομοίωση σταματά όταν η επιθυμητή 

ακμή εμφανιστεί σε όλες τις κυματομορφές 

Edge-Or Η προσομοίωση σταματά όταν υπάρξει 

μετάβαση σε οποιαδήποτε από τις 

επιθυμητές συνθήκες 
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2.1.2 NI Multisim 

 

To NI Multisim, συγκαταλέγεται και αυτό ανάμεσα στο προγράμματα προσομοίωσης 

ηλεκτρονικών και όχι μόνο κυκλωμάτων. Παρουσιάστηκε αρχικά με το όνομα electronics 

workbench και δημιουργήθηκε από μια εταιρία με το όνομα Interactive Image 

Technologies. Στα πρώτα βήματα της εμφάνισης του χρησιμοποιούνταν ως εκπαιδευτικό 

εργαλείο για να διδάξει τους ηλεκτρονικούς μηχανικούς ή τεχνικούς, στα κολέγια τον 

τρόπο σχεδιασμού και ελέγχου των ηλεκτρικών κυκλωμάτων (Καλοβρέκτης & Γκοτσίνας, 

2007). 

Το λογισμικό αυτό προσέφερε σειρά πλεονεκτημάτων όπως : 

 Οπτικοποίηση και επεξεργασία εννοιών του κυκλώματος 

 Οπτικοποίηση και επεξεργασία των εξισώσεων 

 Δημιουργία αναπτυξιακών έργων στο ίδιο περιβάλλον 

 Ταχύτερη βελτιστοποίηση των σχεδίων με ακριβή επιλογή των εξαρτημάτων 

 Διαισθητική ανάλυση και οπτικοποίηση των σχεδίων μέσω προσομοίωσης 

 Γρήγορη διάταξη και περιβάλλον δρομολόγησης με NI Ultiboard  

 Απλοποιημένη σχεδίαση του υλικού NI των εξαρτημάτων 

 Ολοκληρωμένη καινοτόμα επικύρωση με NI LabVIEW 

Το 2005, έγινε εξαγορά της εταιρίας παραγωγής του από την National Instruments 

Electronics Workbench και το Multisim μετονομάστηκε σε NI Multisim. H National 

Instruments έχει διατηρήσει την εκπαιδευτική κληρονομία της με μια συγκεκριμένη 

έκδοση του Multisim η όποια διαθέτει χαρακτηριστικά που αναπτύχθηκαν αποκλειστικά 

για διδασκαλία (Καλοβρέκτης & Γκοτσίνας, 2007). 

Τα γνωστότερα εργαλεία του λογισμικού αυτού είναι :   

 Αναλογικά κυκλώματα  

 Αντιστάσεις, πυκνωτές και επαγωγικά κυκλώματα  

 Σταθεροποιημένη κατάσταση και παροδικές τεχνικές 

ανάλυσης κυκλωμάτων  

 AC ανάλυση και απόκριση συχνότητας  
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 Λειτουργικό ενισχυτή και φίλτρο κυκλώματος  

 Ψηφιακά κυκλώματα  

 Άλγεβρα bool και ελαχιστοποίηση των λογικών 

κυκλωμάτων  

 Ακολουθιακή και Συνδυαστική λογική σχεδίαση  

 Αριθμητική λογική  

 Γλώσσες περιγραφής υλικού και προγραμματιζόμενες 

συστοιχίες πυλών  

 Δυναμικά Ηλεκτρονικά  

 Μετατροπή AC σε DC  

 Μετατροπή DC σε DC λειτουργίας διακόπτη τροφοδοσίας.  

 DC σε AC για την κίνηση οχημάτων και τις ανανεώσιμες 

πηγές ενέργειας  

 Ανορθωτές, μετατροπείς, και διακόπτες ρεύματος  

 PWM και κινητικές μονάδες  

Το ιδιαίτερα εύχρηστο αυτό λογισμικό παρέχει μία πληθώρα εικονικών οργάνων μέτρησης 

και παραγωγής ηλεκτρικών μεγεθών τα οποία δίνουν στο χρήστη τη δυνατότητα 

παραγωγής και μέτρησης ηλεκτρικών μεγεθών όπως τάσεις, ρεύματα, κυματομορφές κ.α 

(Καλοβρέκτης & Γκοτσίνας, 2007).  

Το MultiSIM προκειμένου να διευκολύνει τον χρήστη στη διαδικασία επιλογής και 

εισαγωγής οργάνων στον χώρο εργασίας, παρέχει μία μπάρα με εικονικά όργανα η οποία 

βρίσκεται στα δεξιά του χώρου εργασίας. 

Η μπάρα με τα όργανα αποτελείται από διάφορα πλήκτρα το καθένα από τα οποία 

αντιστοιχούν και σε ένα εικονικό όργανο. Για να τοποθετηθεί ένα όργανο στο χώρο 

εργασίας, αυτό που χρειάζεται από το χρήστη είναι να κάνει κλικ στο όργανο που 

επιθυμεί, και να το τοποθετήσει στον καμβά χρησιμοποιώντας τον κέρσορα του ποντικού. 

Στην εικόνα που ακολουθεί παρουσιάζεται αναλυτικά η μπάρα του μενού του Multisim 

(Καλοβρέκτης & Γκοτσίνας, 2007). 
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Εικόνα 8 : Βασικό μενού (Καλοβρέκτης & Γκοτσίνας, 2007) 

 

1. Ψηφιακό Πολύμετρο (Multimeter) 

2. Αναλυτής Παραμόρφωσης (Distortion Analyzer) 

3. Γεννήτρια Συναρτήσεων (Function Generator) 

4. Μετρητής Watt (Watt Meter) 

5. Παλμογράφος 2 Καναλιών (Oscilloscope) 

6. Μετρητής Συχνότητας (Frequency Counter) 

7. Ευέληκτη Γεννήτρια Συναρτήσεων (Agilent Function Generator) 

8. Παλμογράφος Τεσσάρων Καναλιών (4 Channel Oscilloscope) 

9. Καταγραφέας Διαγραμμάτων Bode (Bode Plotter) 

10. Αναλυτής Χαρακτηριστικών Ημιαγωγικών Στοιχείων (IV-Analyzer) 

11. Γεννήτρια Λέξεων (Word Generator) 

12. Λογικός Μετατροπέας (Logic Converter) 

13. Λογικός Αναλυτής (Logic Analyzer) 

14. Ευέλικτος Παλμογράφος (Agilent Oscilloscope) 

15. Ευέλικτο Πολύμετρο (Agilent Multimeter) 

16. Αναλυτής Φάσματος (Spectrum Analyzer) 

17. Αναλυτής Δικτύου (Network Analyzer) 

18. Παλμογράφος Tektronix (Tektronix Oscilloscope) 

19. Μετρητής Ρεύματος Σημείου (Current Probe) 

20. Όργανο LabVIEW (LabVIEW Instrument) 

21. Ετικέτα μετρήσεων (Measurement Probe) 

 

Τα όργανα τα οποία χρησιμοποιούνται από το λογισμικό αυτό έχουν ως χαρακτηριστικό 

ότι αντιπροσωπεύονται από το αντίστοιχο εικονίδιο όπως ακριβώς αυτά φαίνονται στο 
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χώρο εργασίας και ότι η πρόσοψή τους είναι αρκετή ώστε να γίνουν οι κατάλληλες σε 

αυτά ρυθμίσεις (Καλοβρέκτης & Γκοτσίνας, 2007).  

Παρακάτω φαίνονται τα εικονίδια των βασικών οργάνων που χρησιμοποιούνται συνήθως 

μέσα στο MultiSIM. Από αριστερά, Πολύμετρο, Γεννήτρια Συναρτήσεων, Παλμογράφος, 

Αναλυτής IV, Bode Plotter, Λογικός Μετατροπέας.  

 

Εικόνα 9 : Τα βασικά όργανα στο multisim (Καλοβρέκτης & Γκοτσίνας, 2007) 

 

Ως παράδειγμα κατανόησης του λογισμικού αλλά και παρουσίασης του βασικού μενού 

λειτουργιών αυτού χρησιμοποιήθηκε ο σχεδιασμός ενός φίλτρου.  

 

  

Εικόνα 10 : Παράδειγμα χρήσης (Καλοβρέκτης & Γκοτσίνας, 2007) 

 

Όπως παρουσιάζεται και στην παραπάνω εικόνα, όταν χρησιμοποιούνται και τα δύο 

κανάλια του παλμογράφου, συνίσταται το ένα από αυτά να αλλάζει χρώμα ώστε ο χρήστης 

να έχει την δυνατότητα να ξεχωρίζει τις δύο κυματομορφές κατά τη μέτρηση. Με διπλό 
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κλικ στο εικονίδιο της γεννήτριας παλμών αλλά και σε αυτό του παλμογράφου εισάγονται 

οι παρακάτω ρυθμίσεις :   

  

Εικόνα 11 : Εισαγωγή ρυθμίσεων (Καλοβρέκτης & Γκοτσίνας, 2007) 

 

Από το μενού, Simulate>Run ξεκινά η προσομοίωση, και ο χρήστης είναι πλέον σε θέση 

να δει τα αποτελέσματα αυτής μέσα στον παλμογράφο.  

  

 

Εικόνα 12 : Εμφάνιση αποτελεσμάτων στον παλμογράφο (Καλοβρέκτης & Γκοτσίνας, 2007) 
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2.1.3 Το PSpice 

 

Πρόκειται για ένα ακόμη λογισμικό προσομοίωσης αναλογικών και ψηφιακών 

κυκλωμάτων. Η εταιρία παραγωγής και διανομής του ονομάζεται Cadence Design και το 

παρήγαγε με στόχο να χρησιμοποιηθεί μόνο από τα Windows. Το όνομα του προέρχεται 

από τα ακρωνύμια Personal Simulation Program with Integrated Circuit Emphasis 

ενώ η πρώτη του έκδοση κυκλοφόρησε τον Ιανουάριο του 1984 για να τρέξει σε γνήσιο 

IBM υπολογιστή.  

Καθώς αναπτυσσόταν το λογισμικό αυτό, εξελισσόταν παράλληλα και πλέον αποτελεί ένα 

εξαιρετικό προσομοιωτή αναλογικού και μικτού σήματος (Orchad, 1998). Στόχος ήταν το 

λογισμικό αυτό να ανταπεξέλθει στις πολύπλοκες απαιτήσεις της βιομηχανίας αλλά και να 

μπορεί να λειτουργήσει άψογα σε περιβάλλοντα Cad (Orchad, 1998).  

Στα βασικά του χαρακτηριστικά περιλαμβάνονται η ανάλυση ενός κυκλώματος με 

αυτόματη βελτιστοποίηση, η κρυπτογράφηση, το πρόγραμμα επεξεργασίας μοντέλων, η 

υποστήριξη για παραμετροποιημένα μοντέλα, το σημείο ελέγχου για αυτό-σύγκλιση και 

επανεκκίνηση και η υποστήριξη για το μοντέλο του πυρήνα Tabrizi για μη-γραμμικούς 

πυρήνες. 

Στις δυνατότητες του PSpice συγκαταλέγονται (Orchad, 1998) :  

 DC Ανάλυση - χρησιμοποιείται για τα κυκλώματα με πηγές αμεταβλήτου χρόνου 

(π.χ., σταθερή κατάσταση πηγές dc). Υπολογίζει όλες τις τάσεις και τα ρεύματα σε 

ένα εύρος τιμών.  

 Παροδική Ανάλυση - Χρησιμοποιείται για κυκλώματα με πηγές που έχουν 

μεταβολές χρόνου (π.χ., ac πηγές / μεταγωγή πηγών dc). Υπολογίζει όλες τις τάσεις 

κόμβων και τα τμήματα ρεύματος πάνω από ένα χρονικό διάστημα και οι 

στιγμιαίες τιμές τους είναι οι έξοδοι.  

 AC Ανάλυση - Χρησιμοποιείται για την μικρού σήματος ανάλυση των 

κυκλωμάτων με πηγές διαφορετικών συχνοτήτων. Υπολογίζει, επίσης, όλες τις 

τάσεις και τα ρεύματα κομβικών τμημάτων (σε ένα εύρος συχνοτήτων) και τα 

μεγέθη τους και τις γωνίες φάσης.  

Το περιβάλλον εργασίας του λογισμικού αυτού δε δίνει τη δυνατότητα οποιασδήποτε 

ενέργειας από τη στιγμή εκκίνησής του. Αρχικά, δίνεται μονάχα η δυνατότητα ρυθμίσεων 
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που αφορούν στο περιβάλλον εργασίας, η εκκίνηση νέων ή το άνοιγμα παλαιότερων 

project, η εκτύπωση και άλλα (Orchad, 1998). Στην εικόνα που ακολουθεί παρουσιάζεται 

το βασικό μενού εκκίνησης.  

 

Εικόνα 13 : Βασικό μενού εκκίνησης του PSpice (Orchad, 1998) 
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Τα στοιχεία που χαρακτηρίζουν το εισαγωγικό περιβάλλον του προγράμματος, όπως 

φαίνεται και από την παραπάνω εικόνα είναι ένα menu επιλογών, κάποια button 

συντόμευσης (γραμμή εργαλείων - toolbar), τη γραμμή κατάστασης (status bar), και ένα 

επιπλέον πλαίσιο διαλόγου (Session Log), το οποίο και αποτελεί το τρέχον ημερολόγιο του 

προγράμματος (Orchad, 1998).  

Οι λειτουργίες αλλά και οι διάφορες ρυθμίσεις που αφορούν στο πρόγραμμα διεξάγονται 

από το μενού επιλογών και αφορούν κυρίως στη διαχείριση και την προσπέλαση των 

αρχείων ενός project, στον καθορισμό κάποιων χαρακτηριστικών του προγράμματος, και 

στις διάφορες διαδικασίες εξομοίωσης και προβολής των αποτελεσμάτων. Βασικό 

χαρακτηριστικό του μενού επιλογών είναι τα πεδία εκείνα που αποτελούν την περιγραφή 

της γενικότερης κατηγορίας των εργασιών (Orchad, 1998). Έτσι, οι διάφορες εργασίες-

επιλογές είναι ταξινομημένες ανάλογα σε διάφορα (pull-up) υπο-menu - λίστες οι οποίες 

ενεργοποιούνται και εμφανίζονται κατόπιν την κατάλληλης επιλογής του αντίστοιχου 

πεδίου.  

Ο χρήστης μπορεί να ενεργοποιήσει ένα και μόνο πεδίο από τη λίστα επιλογών ενώ η 

ενεργοποίηση ενός δεύτερου πεδίου σημαίνει αυτόματα απενεργοποίηση του πρώτου. 

Στην εκκίνηση του προγράμματος, μπορεί κανείς να παρατηρήσει την ύπαρξη των πεδίων 

File, View, Edit, Options, Window και Help καθώς πολλά ακόμη που υπάρχουν δεν 

εμφανίζονται. Τα κυριότερα από αυτά τα πεδία περιγράφονται παρακάτω (Orchad, 1998):  

• File  : Το πεδίο αυτό σχετίζεται με μια σειρά υπο-επιλογών που αφορούν τη διαχείριση 

και την προσπέλαση των αρχείων εξομοίωσης (Δημιουργία νέου αρχείου ή Project, 

Αποθήκευση, Άνοιγμα ήδη υπάρχοντος αρχείου ή Project κτλ). Με την υπο-επιλογή 

“Import” είναι δυνατή η εισαγωγή δεδομένων για εξομοίωση υπό μορφή σχηματικού 

διαγράμματος από συμβατά προγράμματα. Απαραίτητη προϋπόθεση είναι η ύπαρξη 

κατάλληλου output file από το έτερο πρόγραμμα. Ως χαρακτηριστικό παράδειγμα 

αναφέρουμε το σχεδιαστικό πακέτο κυκλωμάτων ηλεκτρονικής Protel DXP της εταιρίας 

Altium. Τέλος, από το πεδίο αυτό είναι δυνατή η εκτύπωση όπως και η προεπιλογή των 

ρυθμίσεων του εκτυπωτή.  

• Edit : Σε αυτό το πεδίο, γενικά, είναι δυνατή η επεξεργασία των διαφόρων τμημάτων και 

προ-επιλεγμένων αντικειμένων του project (αντιγραφή, αποκοπή, επικόλληση, διαγραφή, 

περιστροφή κτλ.). Πρέπει επίσης να επισημανθεί το γεγονός ότι μέσω της επιλογής PSpice 

Stimulus καθίσταται δυνατή η ρύθμιση των ιδιοτήτων των AC Stimulus πηγών κατά τη 
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διαδικασία δημιουργίας σχηματικού διαγράμματος στο αντίστοιχο παράθυρο (Schematic 

Editor).  

• View : Σε αυτό το πεδίο διεξάγονται οι ρυθμίσεις προβολής του περιβάλλοντος εργασίας. 

Κατά την εκκίνηση του προγράμματος (και εφ’ όσον παραμένουμε στο εισαγωγικό 

περιβάλλον) είναι δυνατή μόνο η ρύθμιση εμφάνισης/απόκρυψης της γραμμής εργαλείων 

(toolbar). Από το πεδίο αυτό επίσης, παρέχονται επιλογές για την προβολή των διαφόρων 

αποτελεσμάτων εξομοίωσης καθώς και των output files.  

• Options : Το πεδίο αυτό αφορά τις διάφορες ρυθμίσεις και επιλογές που σχετίζονται είτε 

με το περιβάλλον εργασίας, είτε με κάποιο προ-επιλεγμένο αντικείμενο (διαστάσεις 

σελίδας, χρωματικοί συνδυασμοί, γραμματοσειρές κτλ.).  

• Window : Το πεδίο αυτό περιέχει ρυθμίσεις που κατά κανόνα αφορούν την προβολή των 

διαφόρων παραθύρων του προγράμματος. Μια ολοκληρωμένη διαδικασία εξομοίωσης 

περιλαμβάνει πολλά στάδια εργασίας και επεξεργασίας αποτελεσμάτων. Ξεκινώντας από 

τη δημιουργία του σχηματικού διαγράμματος και τη δημιουργία αρχείου Bias Point, μέχρι 

την AC Transient και Sweep Ανάλυση. Για ευνόητους λόγους, τα διάφορα αυτά δεδομένα 

απεικονίζονται σε διαφορετικά παράθυρα. Είναι ωστόσο δυνατό, για λόγους αμεσότητας 

και περιορισμού του χρόνου εργασίας, να επιθυμούμε την παράλληλη απεικόνιση των 

δεδομένων αυτών. Έτσι λοιπόν, μέσω των επιλογών του πεδίου Window είναι δυνατή η 

ρύθμιση του τρόπου προβολής των διαφόρων αυτών παραθύρων του προγράμματος.  

• Tools : Σε αυτό το πεδίο περιέχονται χρήσιμες λειτουργίες του συστήματος. Με την 

επιλογή Bill of Materials δημιουργείται αυτόματα από το πρόγραμμα η λίστα των υλικών 

που απαιτούνται για την υλοποίηση της σχεδίασης. Με την επιλογή Create Netlist 

δημιουργείται το κατάλληλο αρχείο διασύνδεσης των πληροφοριών του σχηματικού 

διαγράμματος (Capture) με το συμβατό πακέτο σχεδίασης τυπωμένων κυκλωμάτων 

(OrCAD Layout) ή άλλα συμβατά πακέτα δημιουργίας PCB, ενώ με την επιλογή Design 

Rules Check ελέγχεται η ορθότητα της σχεδίασης.  

• Pspice  : Στο παρών πεδίο διεξάγονται οι ρυθμίσεις, η εκτέλεση και η προβολή των 

αποτελεσμάτων μιας εξομοίωσης. Επίσης με την επιλογή “Create Netlist” δημιουργείται 

το κατάλληλο αρχείο διασύνδεσης των πληροφοριών του σχηματικού διαγράμματος 

(Capture) με το συμβατό πακέτο σχεδίασης τυπωμένων κυκλωμάτων (OrCAD Layout) 

ενώ με την επιλογή “View Netlist” είναι δυνατή η προβολή του αρχείου αυτού.  
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• Place : Το πεδίο αυτό εμφανίζεται μόνο στο σχηματικό συντάκτη (Schematic Editor) και 

περιέχει τις επιλογές των στοιχείων για τη δημιουργία του σχηματικού διαγράμματος. 

Μέσω αυτών καθίσταται δυνατή η τοποθέτηση των διαφόρων εξαρτημάτων - στοιχείων 

και η καλωδίωσή (γαλβανική ένωσή) τους στο σχηματικό διάγραμμα. Επιπλέον παρέχεται 

και η δυνατότητα δημιουργίας γραφικών σχεδίων. (Τα γραφικά σχέδια χρησιμοποιούνται 

αποκλειστικά για τη βελτίωση της αισθητικής ενός σχηματικού χωρίς να επηρεάζουν στο 

ελάχιστο τα ηλεκτρικά χαρακτηριστικά αυτού).  

• Simulation : Το πεδίο αυτό εμφανίζεται μόνο στα παράθυρα απεικόνισης των 

αποτελεσμάτων εξομοίωσης(OrCAD PSpice A/D). Από εδώ είναι εφικτές οι βασικές 

επιλογές και λειτουργίες της εξομοίωσης. Μέσω κατάλληλων ρυθμίσεων είναι δυνατή η 

επιλογή του τύπου της εξομοίωσης (Bias Point, DC Sweep, AC Transient, AC Sweep), η 

επιλογή του χρονικού διαστήματος καθώς και λειτουργίες ελέγχου όπως η εκτέλεση, η 

παύση και η διακοπή αυτής.  

• Trace : Το πεδίο αυτό εμφανίζεται μόνο στα παράθυρα απεικόνισης των αποτελεσμάτων 

εξομοίωσης (OrCAD PSpice A/D). Από εδώ καθίσταται δυνατή η επιλογή των διαφόρων 

προς απεικόνιση μεγεθών - στοιχείων (τάσεις, ρεύματα) όπως και η ενεργοποίηση cursor 

για την εύκολη και ακριβή προβολή των τιμών στα διάφορα σημεία των κυματομορφών. 

Επίσης παρέχεται η δυνατότητα προβολής - μετασχηματισμού των αποτελεσμάτων από το 

πεδίο του χρόνου στο πεδίο της συχνότητας (Fourier) και αντίστροφα.  

• Plot : Το πεδίο αυτό ενεργοποιείται μόνο στα παράθυρα απεικόνισης των 

αποτελεσμάτων εξομοίωσης(OrCAD PSpice A/D). Μέσω των επιλογών του είναι δυνατή 

η κατ’ επιλογή γραφική απεικόνιση παραστάσεων με επιλεγμένες εξαρτημένες και 

ανεξάρτητες μεταβλητές (y=F(x)). Με άλλα λόγια είναι εφικτή η επιλογή των μεγεθών 

στους άξονες Χ και Y. Αυτό είναι ιδιαίτερα σημαντικό για περιπτώσεις όπου απαιτείται η 

απεικόνιση του σήματος εξόδου συναρτήσει του σήματος εισόδου όπως συμβαίνει για τις 

περιπτώσεις ελέγχού της γραμμικότητας των κυκλωμάτων. Επίσης, από την επιλογή αυτή 

είναι δυνατή η ρύθμιση της κλίμακας των αξόνων όπως και η προσθήκη ετικετών, 

γραμμών και γραφικών σχεδίων επί της γραφικής απεικόνισης των αποτελεσμάτων.  

• Help : Το πεδίο αυτό αφορά τη χρήση βοήθειας σχετικά με τη λειτουργία και τις πιθανές 

παραμέτρους του προγράμματος. Η επιλογή αυτή αποτελεί ένα πολύ σημαντικό στοιχείο, 

καθώς απευθύνεται σε όλους τους χρήστες (αρχάριους και μη) ανάλογα με το είδος και τη 

φυσιολογία του προβλήματος που συνάντησαν.  
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Η γραμμή εργαλείων του PSpice αποτελείται από μία σειρά κουμπιών που έχουν ως στόχο 

να διευκολύνουν το χρήστη στο σχεδιασμό των κυκλωμάτων και στον καθορισμό των 

επιλογών.  Τα κυριότερα κουμπιά που εμφανίζονται στην γραμμή εργαλείων είναι  

(Orchad, 1998):  

Κουμπί Λειτουργία 

 

Δημιουργία νέου αρχείου ή project εναλλακτικά 

έχουμε: File → New → Project  

 

 

Άνοιγμα ήδη υπάρχοντος αρχείου ή Project  

εναλλακτικά έχουμε: File → Open → Project  

 

Αποθήκευση του αρχείου ή project  

εναλλακτικά έχουμε: File → Save  

 

Εκτύπωση του φύλλου εργασίας  

εναλλακτικά έχουμε: File → Print  

 

Αποκοπή προεπιλεγμένου αντικειμένου  

εναλλακτικά έχουμε: Edit → Cut  

 

Αντιγραφή προεπιλεγμένου αντικειμένου  

εναλλακτικά έχουμε: Edit → Copy  

 

Επικόλληση αντικειμένου (του Clipboard)  

εναλλακτικά έχουμε: Edit → Paste  

 

Αναίρεση πληκτρολόγησης  

εναλλακτικά έχουμε: Edit → Undo  

Εστίαση με μεγέθυνση της προβολής  

εναλλακτικά έχουμε: View → Zoom → In  
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Εστίαση με σμίκρυνση της προβολής  

εναλλακτικά έχουμε: View → Zoom → Out  

 

Εστίαση σε επιλεγμένη περιοχή προβολής  

εναλλακτικά έχουμε: View → Zoom → Area  

 

Εστίαση με προβολή όλης της σελίδας  

εναλλακτικά έχουμε: View → Zoom → All 

 

Χρήση Βοήθειας σχετικά με το πρόγραμμα 

εναλλακτικά έχουμε: Help → Help Topics  

 

Πέρα από τη γραμμή εργαλείων στο PSpice συναντάται και η γραμμή κατάστασης η οποία 

εντοπίζεται στο κάτω μέρος της οθόνης και ενημερώνει το χρήστη για τις τρέχουσες 

λειτουργίες του προγράμματος.  

Προκειμένου να ξεκινήσει ο σχεδιασμός ενός κυκλώματος προφανώς και απαιτείται η 

δημιουργία ενός νέου Project. Για την δημιουργία ενός νέου project στο πρόγραμμα o 

χρήστης ακολουθεί τα παρακάτω βήματα : File → New → Project (Orchad, 1998). Στη 

συνέχεια εμφανίζεται ένα πλαίσιο διαλόγου (New Project) στο οποίο είναι ορατή η 

δυνατότητα δημιουργίας project μέσω των επιλογών: Analog or Mixed A/D, PC Board 

Wizard, Programmable Logic Wizard και Schematic. Κάθε επιλογή αποσκοπεί σε 

συγκεκριμένη χρήση των δυνατοτήτων του προγράμματος ανάλογα με τις εκάστοτε 

απαιτήσεις. Έτσι έχουμε (Orchad, 1998):  

• Analog or Mixed A/D  : Η επιλογή αυτή αποσκοπεί σε χρήση του παραγόμενου 

σχηματικού διαγράμματος για εξομοίωση αναλογικών ή υβριδικών (ψηφιακών και 

αναλογικών) ηλεκτρονικών διατάξεων. Για το σκοπό αυτό, εκτός από τα στοιχεία των 

σχηματικών σχεδίων των βιβλιοθηκών του προγράμματος (OrCAD PSpice), γίνονται 

διαθέσιμα και δεδομένα που αφορούν την ηλεκτρική συμπεριφορά των εξαρτημάτων.  

• PC Board Wizard : Με την επιλογή αυτή παρέχεται η δυνατότητα περαιτέρω 

αξιοποίησης του σχηματικού διαγράμματος για την δημιουργία μακετών τυπωμένων 

κυκλωμάτων (PCB - Printed Circuit Board). Αυτό ωστόσο είναι εφικτό μόνο με τη χρήση 

ενός κατάλληλου συμβατού προγράμματος, του “OrCAD Layout”. Οι πληροφορίες 

διασύνδεσης των εξαρτημάτων μεταφέρονται από το σχηματικό διάγραμμα (Capture) στο 
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πρόγραμμα “OrCAD Layout” με τη βοήθεια ενός ειδικού αρχείου (netlist), όπου σε 

συνδυασμό με τα “footprints” των διαφόρων εξαρτημάτων χρησιμοποιούνται για να 

αποδώσουν τη μακέτα του τυπωμένου κυκλώματος (PCB).  

• Programmable Logic Wizard : Με την επιλογή αυτή παρέχεται η δυνατότητα 

σχεδίασης και υλοποίησης διατάξεων που περιέχουν προγραμματιζόμενες λογικές 

διατάξεις (CPLD, FPGA). Αυτό όμως, προϋποθέτει και την συμπληρωματική χρήση ενός 

κατάλληλου συμβατού προγράμματος, του “OrCAD Express”.  

• Schematic : Με την ενεργοποίηση της επιλογής αυτής καθίσταται δυνατή η δημιουργία 

μόνο σχηματικών διαγραμμάτων των κυκλωμάτων χωρίς καμία μετέπειτα δυνατότητα 

επεξεργασίας. Αυτό συμβαίνει γιατί έτσι γίνονται διαθέσιμα (φορτώνονται) στο 

πρόγραμμα μόνο τα δεδομένα των βιβλιοθηκών που σχετίζονται με τα σχηματικά σύμβολα 

των στοιχείων και όχι αυτά που περιέχουν την ηλεκτρική συμπεριφορά των 

χρησιμοποιούμενων εξαρτημάτων.  

Καθώς ο χρήστης δημιουργεί το Project, λαμβάνει από το λογισμικό μία πληθώρα 

επιλογών που αφορούν στην καταχώρηση αλλά και την αποθήκευση των αρχείων που 

επεξεργάστηκε. Έτσι, στο πεδίο “name” δίνουμε το όνομα του Project, ενώ στο πεδίο 

“Location” με τη βοήθεια του File Manager (πλήκτρο Browse) δίνουμε τον προορισμό 

“path” του φακέλου στον οποίο θα περιέχονται τα διάφορα αρχεία του εν λόγω project.  
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2.1.4 Το QUCS - Quite Universal Circuit Simulator 

 

Είναι ένας πρόγραμμα προσομοίωσης ηλεκτρονικών κυκλωμάτων ανοιχτού κώδικα που 

δημιουργήθηκε από την GPL και πιο συγκεκριμένα από τον Michael Margraf ενώ 

διατέθηκε στην αγορά τον Ιούνιο του 2013. Υποστηρίζεται από Mac OS, Windows, 

Linux/GNU, Solaris, FreeBSD (Jahn & Borras, 2007). Πρόκειται για έναν ολοκληρωμένο 

προσομοιωτή κυκλωμάτων ο οποίος είναι σε θέση να συνδυάσει το σχεδιασμό ενός 

κυκλώματος με μια ιδιαίτερα φιλική προς το χρήστη διεπαφή και να προσομοιώσει τη 

συμπεριφορά μεγάλου και μικρού σήματος καθώς και τη συμπεριφορά του θορύβου του 

κυκλώματος.  

 

Εικόνα 14 : Το περιβάλλον εργασίας του QUCS (Jahn & Borras, 2007) 

 

Η διεπαφή χρήστη που χρησιμοποιεί το λογισμικό είναι ιδιαίτερα εξελιγμένη και επιτρέπει 

ακόμη και την παρουσίαση των αποτελεσμάτων με διάφορες μορφές διαγραμμάτων. 

Πέραν τούτου, το QUCS, επιτρέπει την εισαγωγή ήδη υπαρχόντων και σχεδιασμένων 

μοντέλων ώστε αυτά να μπορούν να χρησιμοποιηθούν στις προσομοιώσεις (Jahn & 

Borras, 2007). Χρήσιμο κομμάτι του προγράμματος είναι η τεράστια σειρά εξαρτημάτων 

και των μοντέλων που διαθέτει όπως το HICUM, BSIM2, BSIM3 και σύντομα BSIM6. 

Παρέχει επίσης πολλούς ημιαγωγούς βασισμένους σε στοιχεία και μοντέλα όπως το 

opamps, MOSFET, Pmosfet, διόδους και πολλά άλλα.  
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Εικόνα 15 : Σειρά εξαρτημάτων και μοντέλων που περιλαμβάνονται στο λογισμικό (Jahn & Borras, 2007) 

 

Τα κυριότερα εργαλεία του λογισμικού αυτού είναι (Jahn & Borras, 2007) :  

 Qucs αποτελείται από πολλά αυτόνομα προγράμματα που αλληλοεπιδρούν μεταξύ 

τους μέσω των GUCS.  

 Το GUI χρησιμοποιείται για να δημιουργήσει σχηματικές παραστάσεις και 

προσομοιώσεις εγκατάστασης δίνοντας τα αποτελέσματα της προσομοίωσης στην 

οθόνη μέσω VHDL κώδικα.  

 Ο αναλογικός προσομοιωτής είναι ένα πρόγραμμα γραμμής εντολών που 

εκτελείται από το GUI προκειμένου να προσομοιάσει τη σχηματική παράσταση 

που είχε εγκατασταθεί προηγούμενα. Παίρνει ένα netlist, ελέγχει για σφάλματα, 

εκτελεί τις απαιτούμενες ενέργειες προσομοίωσης, και τελικά παράγει ένα σύνολο 

δεδομένων.  

 Ο επεξεργαστής κειμένου χρησιμοποιείται για να εμφανίσει τα netlists και την 

προσομοίωση πληροφοριών σύνδεσης, όπως επίσης να επεξεργαστεί τα αρχεία που 
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περιλαμβάνονται σε ορισμένα εξαρτήματα (π.χ. Netlists, SPICE, ή τα αρχεία 

Touchstone).  

 Η εφαρμογή του φίλτρου σύνθεσης μπορεί να χρησιμοποιηθεί για το σχεδιασμό 

διαφόρων τύπων των φίλτρων.  

 Ο υπολογιστής γραμμής μεταφοράς μπορεί να χρησιμοποιηθεί για το σχεδιασμό 

και την ανάλυση διαφόρων τύπων των γραμμών μεταφοράς (π.χ. microstrips, 

ομοαξονικά καλώδια).  

 Η εφαρμογή «Διαχειριστής βιβλιοθήκης» έχει μοντέλα για ηλεκτρονικά 

εξαρτήματα που χρησιμοποιούνται στην καθημερινότητα (π.χ. τρανζίστορ, 

διόδους, γέφυρες, opamps) και μπορούν να επεκταθούν από το χρήστη.  

 Η εφαρμογή εξασθενητής σύνθεσης μπορεί να χρησιμοποιηθεί για το σχεδιασμό 

διαφόρων τύπων παθητικών εξασθενητών.  
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2.1.5 Electric  

 

Το Electric VLSI σύστημα σχεδιασμού είναι ένα εργαλείο EDA γραμμένο από τον Steven 

M. Rubin. Χρησιμοποιείται για να αποτυπώνει σχηματικές παραστάσεις και 

ολοκληρωμένα σχέδια κυκλωμάτων ενώ μπορεί πολύ εύκολα να χρησιμοποιήσει και τις 

γλώσσες περιγραφής υλικού όπως VHDL και Verilog (Ruben, 2000). Η διανομή του 

λογισμικού αυτού είναι ελεύθερη καθώς είναι ένα έργο που υποστηρίζεται από την 

κοινότητα GNU. Είναι γραμμένο στη γλώσσα Java και έχει εκδοθεί υπό την GNU GPL.  

To λογισμικό αυτό θεωρεί πως τα ολοκληρωμένα κυκλώματα αποτελούνται από κόμβους 

και τόξα και έτσι ως κόμβους θεωρεί τα στοιχεία των κυκλωμάτων όπως τα τρανζίστορ 

και οι επαφές ενώ ως τόξα τις συνδέσεις μεταξύ των κόμβων (Ruben, 2000). 

Το πρότυπο αυτό σχεδιασμού διαφέρει κατά πολύ από τα τυπικά συστήματα διάταξης 

καθώς δίνει στο χρήστη τη δυνατότητα να εκτελέσει σχέδια που δεν είναι έτοιμα. Το 

παραπάνω σημαίνει ότι τα σχέδια αυτά δεν υπακούν στον έλεγχο των σχεδιαστικών 

κανόνων, χαρακτηριστικό ιδιαίτερα χρήσιμο κατά τη διαδικασία του σχεδιασμού. Τέλος, 

επειδή τα σχέδια αποθηκεύονται εσωτερικά ως ένα γράφημα, ο έλεγχος LVS είναι 

εξαιρετικά γρήγορος και συχνά τρέχει σε λιγότερο από ένα δευτερόλεπτο (Ruben, 2000). 

Η δυνατότητα να τρέξει το LVS είναι σχεδόν ακαριαία σε μεγάλα σχέδια. 

Τα κυριότερα εργαλεία του Electric VLSI είναι (Ruben, 2000)  :  

 Ο Κανόνας Ελέγχου Σχεδιασμού που έχει δυο ελεγκτές και δυο διεπαφές.  

 Ο Κανόνας Ηλεκτρικού Ελέγχου και ο Κανόνας ελέγχου κεραίας (Antenna effect).  

 Δυο ενσωματωμένους προσομοιωτές και πάνω από 12 βιομηχανικά εργαλεία 

(Spice, Verilog, κλπ.)  

 Δρομολογεί πέντε διαφορετικά routers για διαφορετικούς- ειδικούς σκοπούς.  

 Διαθέτει μια γεννήτρια PLA, μια γεννήτρια κυττάρων, μια γεννήτρια πλαισίου και 

μια γεννήτρια ROM  

 Το Logical Effort που αλλάζει ένα κύκλωμα και ξαναδίνει μέγεθος στις πύλες.  
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Εικόνα 16 : Το περιβάλλον σχεδιασμού του Electic VLSI (Ruben, 2000) 

 

Έχει παρατηρηθεί ότι άνθρωποι με μηδενική εμπειρία νιώθουν άνεση με το ασυνήθιστο 

αυτό στυλ ενώ άλλοι που έχουν εμπειρία layout με άλλα προγράμματα προβληματίζονται 

κατά τη χρήση του. Ένα ακόμα πλεονέκτημα αυτής της θεώρησης είναι ότι είναι εύκολο 

να προστεθούν περιορισμοί στις ακμές. Συνοπτικά αναφέρονται οι παρακάτω δυνατότητες   

(Ruben, 2000) : 

 Έλεγχος σχεδιαστικών κανόνων 

 Έλεγχος ηλεκτρικών κανόνων 
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 Προσομοίωση layout 

 Δρομολόγηση (routing) 

 Υποστήριξη των format CIF, GDS, EDIF, DXF, και VHDL. 

 Εκτίμηση λογική προσπάθειας 

 Υποστήριξη των τεχνολογιών CMOS, NMOS, διπολικού transistor, 

σχεδιαγραμμάτα (Schematics) 
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2.1.6 Το Ngspice  

 

Το Ngspice είναι ένα προσομοιωτής κυκλώματος μορφής mixed-level/mixed-signal. Είναι 

ο διάδοχος ανοιχτού κώδικα της Spice3f5 άλλα διαθέτει επίσης και το Cider1b1 και το 

Xspice. Μέσω του προγράμματος αυτού μπορούν να πραγματοποιηθούν μη γραμμικές 

αναλύσεις DC, μη γραμμικές παροδικές αναλύσεις και γραμμικές αναλύσεις AC (Vogt & 

Nenzi, 2014). Μια μικρή ομάδα προγραμματιστών και η κοινότητα των χρηστών 

συνέβαλαν σημαντικά στο έργο του ngspice παρέχοντας του νέα χαρακτηριστικά, 

βελτιώσεις και διορθώσεις σφαλμάτων. 

 

Εικόνα 17 : Το περιβάλλον του NGSpice (Vogt & Nenzi, 2014) 

Το πρόγραμμα δημιουργήθηκε κατά βάση από χρήστες. Γράφτηκε σε γλώσσα 

προγραμματισμού C. Με σταθερή ημερομηνία κυκλοφορίας στην αγορά τον Δεκέμβριο 
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του 2008 και είναι διαθέσιμο στα αγγλικά. Από τότε έχουν γίνει δύο βελτιστοποιήσεις το 

2009, άλλες δύο το 2010 και από μια βελτιστοποίηση τα υπόλοιπα έτη μέχρι σήμερα. Tα 

βασικότερα εργαλεία του λογισμικού είναι (Vogt & Nenzi, 2014) :  

 Το SPICE αποτελεί την πηγή όλων των προσομοιωτών ηλεκτρονικών 

κυκλωμάτων και οι διάδοχοί του χρησιμοποιούνται ευρέως στην κοινότητα των 

ηλεκτρονικών.  

 Το Xspice είναι μια επέκταση του Spice3 που παρέχει πρόσθετα μοντέλα κώδικα 

γραμμένα σε γλώσσα C για να υποστηρίξει αναλογικά μοντέλα συμπεριφοράς και 

συν-προσομοίωσης των ψηφιακών στοιχείων μέσα από ένα γρήγορο συμβάν με 

γνώμονα έναν αλγόριθμο.  

 Το CIDER προσθέτει έναν αριθμητικό προσομοιωτή συσκευής στο Ngspice. 

Συνδέει το επίπεδο προσομοιωτή κυκλώματος με το προσομοιωτή συσκευής για να 

παρέχουν βελτιωμένα αποτελέσματα και ακρίβεια στην προσομοίωση. Τα κρίσιμα 

εργαλεία μπορούν να περιγράφουν μέσω των τεχνολογικών τους παραμέτρων 

(αριθμητικά μοντέλα) και άλλα μπορούν να χρησιμοποιήσουν τα γνήσια μοντέλα 

της Ngspice.  
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2.1.7 Circuit Μaker  

 

Δημιουργήθηκε από τον παγκόσμιο ηγέτη στη δημιουργία ηλεκτρονικού σχεδιασμού την 

ένωση επιχειρήσεων Electronics Design Automation (EDA) όπου τα προϊόντα της 

χρησιμοποιούνται ευρέως στην ηλεκτρονική βιομηχανία. Πρόκειται για ένα από τα πλέον 

ισχυρά και εύχρηστα εργαλεία με ιδιαίτερα προηγμένες δυνατότητες σε ότι αφορά στη 

δημιουργία των ηλεκτρονικών σχεδίων (CircuitMaker, 2016). Με το λογισμικό αυτό είναι 

εφικτός ο σχεδιασμός ηλεκτρονικών κυκλωμάτων, netlists εξόδου για TraxMaker, άλλα 

εργαλείων σχεδίασης PCB και autorouters. Τέλος είναι δυνατή η αναπαράσταση και 

προσομοίωση ψηφιακών, αναλογικών και μεικτών κυκλωμάτων καθώς διαθέτει τις πύλες 

και τα ολοκληρωμένα κυκλώματα για τον σχεδιασμό τους άλλα και τον προσομοιωτή 

Berkeley βασισμένο σε SPICE3f5/XSpice.  

 

Εικόνα 18 : Περιβάλλον εργασίας του Circuit Maker (CircuitMaker, 2016) 
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Tα βασικότερα εργαλεία του λογισμικού είναι (CircuitMaker, 2016) :  

 Διαθέτει χώρο 50 συσκευών ανά σχέδιο οποιοδήποτε τύπου.  

 Βιβλιοθήκη των συσκευών περιορίζεται στις 1000.  

 Εκχωρητή συμβόλων και γνωρίσματα Macro.  

 PCB netlist εξάγει σε μορφή TraxMaker.  

 

2.1.8 Το ProfiCAD 

   

Το ProfiCAD έχει σχεδιαστεί για τη σχεδίαση ηλεκτρικών και ηλεκτρονικών κυκλωμάτων, 

σχηματικών αναπαραστάσεων, σχεδιαγραμμάτων των κυκλωμάτων ελέγχου και μπορεί 

ακόμη να χρησιμοποιηθεί για πνευματικά, υδραυλικά και άλλα είδη τεχνικών 

διαγραμμάτων. 

Χαρακτηριστικά (ProfiCad, 2016): 

 Το ευκολότερο CAD για ηλεκτρικά κυκλώματα: Η μέγιστη φροντίδα καταβλήθηκε 

στην εργονομία και την ευκολία χρήσης. Απλά τοποθετήστε ηλεκτρολογικά 

σύμβολα στο σχέδιο και συνδέστε τα καλώδια. 

 Συλλογές με περισσότερα από χίλια σύμβολα: Μπορείτε εύκολα να δημιουργήσετε 

και τα δικά σας σύμβολα στον επεξεργαστή συμβόλων. 

 Υποστηρίζει αυτόματη αρίθμηση των συμβόλων, δημιουργεί λίστες υλικών, λίστες 

καλωδίων, κοστολόγια υλικών και άλλα προηγμένα χαρακτηριστικά (στην 

εμπορική έκδοση). 

 Το πρόγραμμα υποστηρίζει παραπομπές μεταξύ καλωδίων και συμβόλων που 

ανήκουν σε ένα εξάρτημα (π.χ. πηνίο ρελέ + επαφές). Ένα συνδεδεμένο σύμβολο 

σε διαφορετική σελίδα μπορεί να προσπελαστεί κάνοντας κλικ στην παραπομπή. 

 Εξαγωγή των σχεδίων σε μορφή DXF. 

 Πολύγλωσσο περιβάλλον χρήστη. 

 Χαμηλή χρήση πόρων συστήματος. 

 Δωρεάν για προσωπική χρήση. 
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Εικόνα 19 : Το περιβάλλον του ProfiCAD (ProfiCad, 2016): 
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2.  To MentorGraphics IC Graph 

Tο ICgraph είναι ο ολοκληρωμένος IC layout editor που περιέχει υποομάδες εργαλείων 

που το καθιστούν ικανό να υποστηρίζει full custom editing, automated block placement 

and routing, floorplaning και interactive layout verification. 

 

Εικόνα 20 : Το περιβάλλον του MentorGraphics (ProfiCad, 2016): 

 

Οι βασικότερες έννοιες γύρω από το λογισμικό αυτό είναι (ProfiCad, 2016): :  

 Schematic capture: ορίζεται η διαδικασία δημιουργίας σχηματικού (ηλεκτρονικού) 

διαγράμματος με τη βοήθεια ηλεκτρονικού υπολογιστή, της αποθήκευσης και της 

χρησιμοποίησής του από άλλα προγράμματα. 
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 Back Annotation: είναι πληροφορίες (Data) που άλλα προγράμματα εφαρμογές 

επιστρέφουν στο Design Architect και στο DVE (Design Viewpoint Editor). 

 Back Annotation Property Values: οι επιστρεφόμενες αυτές πληροφορίες έχουν 

σχέση με τιμές ιδιοτήτων που επιστρέφονται ενημερωμένες από τις downstream 

εφαρμογές. 

 Electronic Design: είναι το πλήρες σχέδιο το οποίο αποτελείται από δύο στοιχεία. 

Το Component και το Design Viewpoint. 

 Component: είναι ένα αντικείμενο που περιέχει διάφορα σετ από μοντέλα που 

περιγράφουν την λειτουργική, χρονική, γραφική συμπεριφορά από ένα 

ηλεκτρονικό σχέδιο. Το component μπορεί να αντιπροσωπεύει από μια απλή πύλη 

AND, NOT, Multiplexer ή ένα πολύπλοκο ολοκληρωμένο κύκλωμα και 

αποτελείται από models όπως σχηματικό διάγραμμα, σύμβολο, ή VHDL μοντέλα. 

Το component περιέχει επίσης ένα μηχανισμό που ορίζει ποια μοντέλα θα 

χρησιμοποιηθούν κάθε φορά. Αυτός ο μηχανισμός ονομάζεται Component 

Interface. 

 Models: περιγράφουν την λειτουργική (functional) ή την μη λειτουργική (non-

functional) συμπεριφορά ενός σχεδίου. Ένα ή περισσότερα models μπορούν να 

αποτελούν συστατικά μέρη του component. 

 Functional models είναι τα VHDL, Schematics και χρησιμοποιούνται για να 

περιγράψουν την λειτουργία του κυκλώματός μας και από τις εφαρμογές που 

αναλύουν το σχέδιο μας όπως το QuickSim II. 

 Non-functional models δεν περιγράφουν την λειτουργία του κυκλώματος αλλά, 

αλλά στοιχεία, όπως τον χρονισμό του κυκλώματος (technology file) και την 

γραφική εμφάνιση (Symbol).  

 Design Viewpoint: είναι ένα σχεδιαστικό αντικείμενο που προσδιορίζει 

σχεδιαστικές πληροφορίες του σχεδίου μας για τις downstream εφαρμογές. 

Περιέχει όλες τις πληροφορίες διαμόρφωσης του σχεδίου, κατανεμημένες μέσα 

από τέσσερις κατηγορίες κανόνων : Parameter, Primitive, Visible Property, 

Substitute. Οι συγκεκριμένες για κάθε component ιεραρχικές δομές που 

χαρακτηρίζει το design viewpoint είναι απαραίτητες για τις εφαρμογές που θα 

χρησιμοποιήσουν το component. Το design viewpoint περιέχει και άλλα 

αντικείμενα τα οποία δημιουργούνται από εφαρμογές όπως το QuickSim II. 
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 Downstream Applications: έτσι ορίζονται οι εφαρμογές-προγράμματα που 

χρησιμοποιούν το σχέδιο μας μετά την αρχική δημιουργία του στο Design 

Architect, όπως το QUICKSIM II, ACCUSIM, IC GRAPH, IC BLOCK κ.α. Αυτές 

οι εφαρμογές έχουν default design configuration setup. Όταν έχουμε δημιουργήσει 

ένα component μπορούμε να το περάσουμε από μια τέτοια downstream εφαρμογή 

και αυτή σύμφωνα με το default configuration setup δημιουργεί ένα Design 

Viewpoint το οποίο μας βοηθάει στην βελτίωση του σχεδίου μας. 

 Schematic (ή σχηματικό): είναι μια γραφική περιγραφή συμπεριφοράς ενός 

κυκλώματος. Αποτελείται από ένωση και συνδυασμό μεταξύ διαφόρων στοιχείων 

και ηλεκτρικών αντικειμένων. 

Ορισμοί ορολογιών και στοιχείων που σχετίζονται με τα συνθετικά αντικείμενα ενός 

schematic: 

 Instances of logical symbols (ή αντίγραφα λογικών συμβόλων): αυτά μπορούν να 

αντιπροσωπεύουν οτιδήποτε ξεκινώντας από μια απλή πύλη έως ένα 

ολοκληρωμένο κύκλωμα. 

 Nets: τα nets είναι pin-to-pin καλωδιακές συνδέσεις μεταξύ των Instances του 

schematic sheet (σχηματικό φύλλο). 

 Property Name / Value: είναι ονομασίες ιδιοτήτων property name και αντίστοιχα 

οι τιμές property value που παίρνουν. Μας παρέχουν πληροφορίες για τα 

αντικείμενα που χρησιμοποιούμε στο σχέδιο μας. Άλλες ιδιότητες εμφανίζονται 

στο σχέδιο μας και άλλες όχι, ανάλογα από την παράμετρο visibility. 

 Comment Text and Graphics: είναι σχόλια που συνοδεύουν το σχέδιο. Δίνουν 

χρήσιμες πληροφορίες για το schematic sheet. 

Ορισμοί ηλεκτρικών αντικειμένων που χρησιμοποιούνται για την δημιουργία του 

σχεδίου:  

 Pins: είναι τα "ποδαράκια" των ολοκληρωμένων ή γενικότερα ενός symbol 

instance. Ουσιαστικά τα pins είναι τα σημεία συνδέσεως ενός symbol instance και 

των nets. 

 Nets and Buses: ως Net ορίζεται το μοναδικό σήμα (ένα καλώδιο), ενώ ένα σετ 

από σήματα (πολλά καλώδια) ορίζεται ως Bus. 
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 Frames: το Frame είναι ένα γραφικό πλαίσιο το οποίο περιλαμβάνει ένα κύκλωμα 

που υπό συνθήκη περιλαμβάνεται ή επαναλαμβάνεται πολλές φορές στο συνολικό 

σχέδιο μας. Οι συνθήκες ορίζονται από εκφράσεις τύπου FOR, IF, CASE, που 

ακολουθούν ορισμένους κανόνες ώστε η διασύνδεσή τους με το υπόλοιπο 

κύκλωμα να είναι σωστή. 

 Instance: ως instance ορίζεται το πλήρες αντίγραφο, σχηματικό και λειτουργικό, 

από ένα πρωτότυπο symbol. Η διαδικασία της τοποθέτησης των Instance στο 

σχέδιο ονομάζεται Instantiation. 

 Port: το component αυτό χρησιμοποιείτε για να δείξει ότι ένα net έχει εξωτερική 

σύνδεση από το σχέδιο. Έχει μόνο ένα pin και Class Property value (ενός instance) 

"P". 

 Symbol: ένα symbol μπορεί να αντιπροσωπεύει οτιδήποτε, από ένα διακριτό 

εξάρτημα όπως μια αντίσταση, έως ένα πολύπλοκο ολοκληρωμένο κύκλωμα. Είναι 

δηλαδή το σύμβολο αυτού του εξαρτήματος ή κυκλώματος που η εσωτερική του 

λειτουργία μπορεί να ορίζεται ή και όχι κατά την στιγμή της δημιουργίας του. 

 



52 
 

2.1.9 Προσομοιωτές πρώτης γενιάς – SPICE 

 

Το εργαλείο SPICE θεωρείται και σήμερα το βιομηχανικό πρότυπο όσων αφορά τον τομέα 

της προσομοίωσης τόσο των ψηφιακών, όσο και των αναλογικών κυκλωμάτων. Η 

προσέγγιση του απέναντι στα ψηφιακά, η οποία εκτελείται σε επίπεδο τρανζίστορ, είναι 

ότι καλύτερο υπάρχει από άποψη ακρίβειας αποτελεσμάτων. Η συνεχιζόμενη τάση όμως 

των ψηφιακών ολοκληρωμένων να ακολουθούν τον νόμο του Moore εδώ και χρόνια, έχει 

οδηγήσει το πλήθος των τρανζίστορ που τα απαρτίζουν να φτάσουν σε τεράστιους 

αριθμούς, καθιστώντας την διαδικασία προσομοίωσης τους με αυτόν τον τρόπο αδύνατη. 

Τόσο SPICE όσο και όλα τα άλλα εργαλεία αυτής της κατηγορίας δέχεται σαν είσοδο ένα 

netlist που περιγράφει τα στοιχεία του κυκλώματος (τρανζίστορ, αντιστάσεις, πυκνωτές 

κ.τ.λ.) καθώς και τον τρόπο διασύνδεσης τους και εξάγει από αυτά μη-γραμμικές 

διαφορικές αλγεβρικές εξισώσεις προς επίλυση που δίνουν τις τάσεις και τα ρεύματα του 

κυκλώματος. Συγκεκριμένα για κάθε χρονική στιγμή, ανάλογα με το βήμα προσομοίωσης, 

το SPICE δημιουργεί ένα γραμμικό μοντέλο μετατρέποντας εισάγοντας έτσι τόσο τα 

γραμμικά στοιχεία (αντιστάσεις, πυκνωτές, πηνία) όσο και τα μη-γραμμικά (δίοδοι, 

τρανζίστορ) σε ένα γραμμικό σύστημα πινάκων από την λύση του οποίου εξάγει τις τιμές 

των τάσεων και των 

ρευμάτων για την επόμενη χρονική στιγμή.  

 

Εικόνα 21 : Μέθοδος υπολογισμού του συστήματος με χρήση των πινάκων 

Οι συναρτήσεις που εξάγονται είναι μη-γραμμικές διαφορικές αλγεβρικές συναρτήσεις 

που λύνονται με χρήση "πεπλεγμένων" μεθόδων ολοκλήρωσης (implicit integration 

methods), της μεθόδου του Newton και αραιών πινάκων (Μπούντας, 2009).  Μια 
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συνάρτηση καλείται “πεπλεγμένη" όταν ο έμμεσος ορισμός με βάση τον οποίο παρέχεται 

δε δίνει αμέσως την ένδειξη των πράξεων που πρέπει να εφαρμοστούν στις ανεξάρτητες 

μεταβλητές για να βρεθεί η αντίστοιχη τιμή της συνάρτησης. Τέτοιου είδους συναρτήσεις 

χρησιμοποιούνται ευρέως στα εργαλεία προσομοίωσης ηλεκτρονικών κυκλωμάτων.  

Για ένα κύκλωμα που δεν περιέχει μη-γραμμικά στοιχεία η διαδικασία είναι απλή καθώς 

τα χαρακτηριστικά των στοιχείων που το αποτελούν δεν αλλάζουν οπότε η εύρεση των 

τιμών τάσης και ρεύματος γίνεται με την επίλυση της παραπάνω συνάρτησης με τις 

μεθόδους που αναφέρθηκαν (Μπούντας, 2009). Τα προβλήματα όμως αρχίζουν από την 

στιγμή που μη-γραμμικά στοιχεία εμπεριέχονται στο κύκλωμα (δίοδοι-τρανζίστορ). Εκεί 

τα πράγματα περιπλέκουν καθώς ανάλογα με την κατάσταση λειτουργίας κάθε τέτοιου 

στοιχείου διαμορφώνεται ανάλογα και ο πίνακας G. Κάθε φορά που κατά την διάρκεια της 

προσομοίωσης έστω και ένα στοιχείο αλλάξει κατάσταση τότε ολόκληρος ο πίνακας 

πρέπει να επαναϋπολογιστεί. Είναι προφανές λοιπόν ότι για ένα καθαρά ψηφιακό 

κύκλωμα, το οποίο μπορεί να περιέχει τεράστιο αριθμό από τρανζίστορ τα οποία θα 

αλλάζουν διαρκώς καταστάσεις, η απόδοση του SPICE μειώνεται δραματικά, σε βαθμό 

που η χρήση του συγκεκριμένου εργαλείου, αν και παραμένει εξαιρετικά ακριβής, να 

θεωρείται πρακτικά ασύμφορη έως αδύνατη (Μπούντας, 2009). 
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2.1.10 Προσομοιωτές δεύτερης γενιάς – Fast-SPICE 

 

 

Αν και το SPICE θεωρείται ακόμα και σήμερα αξεπέραστο σε επίπεδο ακρίβειας 

αποτελεσμάτων υστερεί σημαντικά στον τομέα του χρόνου που απαιτείται για την 

εκτέλεση της προσομοίωσης, σε βαθμό που καθιστά την χρήση του από πρακτικά 

ασύμφορη έως αδύνατη, ειδικά όταν το κύκλωμα δεν είναι μικρό. Η δημιουργία των 

αντίστοιχων πινάκων και η επίλυση των εξισώσεων σε κάθε βήμα της προσομοίωσης είναι 

μια πάρα πολύ “βαριά” 

διαδικασία από πλευράς υπολογιστικής πολυπλοκότητας (Μπούντας, 2009). Η ανάγκη για 

πιο πρακτικές λύσεις στον τομέα των προσομοιώσεων οδήγησε στην δημιουργίας μιας 

δεύτερης γενιάς προσομοιωτών πολλοί εκ των οποίων ανήκουν στην “χαρακτηριστική” 

κατηγορία των Fast-SPICE προσομοιωτών. Πολλές από τις σημερινές εφαρμογές στον 

τομέα των εργαλείων σχεδίασης (Electronic Design Automation ή αλλιώς EDA) 

βασίζονται σε Fast-SPICE προσομοιωτές οι οποίοι όμως έρχονται με αρκετούς 

περιορισμούς και συμβιβαστικές λύσεις  (Μπούντας, 2009). 

Τα σημαντικότερα πλεονεκτήματα των Fast-SPICE εφαρμογών είναι :  

 Η κατά πολύ μεγαλύτερη ταχύτητα και  

 Οι μειωμένες απαιτήσεις μνήμης σε σύγκριση πάντα με το SPICE που χρειάζονται 

για την προσομοίωση των κυκλωμάτων.  

Αυτή η κατηγορία εργαλείων ειδικεύεται κυρίως στα ψηφιακά κυκλώματα. Η επίλυση 

ωστόσο ενός αναλογικού κομματιού μπορεί να επιτευχθεί με την ενσωμάτωση 

αντίστοιχων λειτουργιών και αλγορίθμων καθώς πρόκειται κατά κύριο λόγο για γραμμικά 

κυκλώματα, επεκτείνοντας έτσι τις δυνατότητες προσομοίωσης σε συνδυασμό ψηφιακού-

αναλογικού κυκλώματος (mixed mode design). 

Η μειωμένη ακρίβεια, σε σχέση με το “απόλυτο” που παρέχει το SPICE αποτελεί το 

σημαντικότερο μειονέκτημα αυτής της κατηγορίας εργαλείων. Αν οι απαιτήσεις σε αυτόν 

τον τομέα είναι υψηλές τότε η χρήση ενός Fast-SPICE εργαλείου ίσως να μην αποτελεί 

την πιο ενδεδειγμένη λύση. Τις περισσότερες φορές ωστόσο μια απώλεια λίγων 

ποσοστιαίων μονάδων σε ακρίβεια είναι αμελητέα όταν συνοδεύεται με μείωση κατά δύο 

τάξεις μεγέθους του απαιτούμενου χρόνου εκτέλεσης της προσομοίωσης. Υπάρχουν 
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επίσης και κάποιοι άλλοι παράγοντες που επηρεάζουν την απόδοση των Fast-SPICE 

εργαλείων και δεν πρέπει να αγνοηθούν: 

· Η ύπαρξη πηνίων μπορεί να προκαλέσει σημαντική μείωση στην απόδοση αν εξαιτίας 

τους δημιουργούνται φαινόμενα ταλάντευσης (όπως συμβαίνει σε RLC κυκλώματα). 

Επακόλουθο μιας τέτοιας συμπεριφοράς από αυτό το φαινόμενο είναι η εκρηκτική αύξηση 

τηςδραστηριότητας του κυκλώματος και, ανάλογα, της απαιτούμενης υπολογιστικής 

προσπάθειας, κάτι που εκτοξεύει τον χρόνο εκτέλεσης. Για να επιτύχουν καλύτερη 

απόδοση οι Fast-SPICE προσομοιωτές ελαχιστοποιούν το φαινόμενο της σύζευξης 

(coupling) μεταξύ των στοιχείων. Γενικά είτε αγνοείται, είτε λύνεται με προσέγγιση 

ανάλογα με τις προδιαγραφές που έθεσε ο χρήστης. Μόνο σε πολύ κρίσιμα κομμάτια του 

κυκλώματος και κυρίως σε coupling capacitors θα γίνει πλήρης ανάλυση. Επιπλέον, όσων 

αφορά τα ψηφιακά κυκλώματα, μια ανάλυση αυτού του φαινομένου στα MOS τρανζίστορ 

μαζί με το δίκτυο διανομής ισχύος (τροφοδοσίας για τα PMOS και γείωσης για τα NMOS) 

θα εξαντλήσει τις δυνατότητες του προσομοιωτή (Μπούντας, 2009). 

· Τέλος, ίσως το μεγαλύτερο πρόβλημα που παρουσιάζουν αυτά τα εργαλεία, είναι ότι για 

να δουλέψουν θεωρούν το δίκτυο διανομής ισχύος σαν ιδανικό και μπορούν να δεχτούν 

μόνο μια σταθερή τιμή τροφοδοσίας πάνω από κάθε block. Η προσθήκη ενός γραμμικού 

κυκλώματος που θα ένωνε όλες ουσιαστικά τις πύλες θα ανάγκαζε το εργαλείο να δει 

ολόκληρο το κύκλωμα σαν μια ενιαία μονάδα θα εξάλειφε την βασική ιδιότητα του 

διαχωρισμού και ανάλυσης μόνο σε μικρούς “ενεργούς“ τομείς του κυκλώματος που θα 

εξηγηθεί παρακάτω. 

Ουσιαστικά θα μετέτρεπε την Fast-SPICE μηχανή σε απλό SPICE με όλες τις μη 

επιθυμητές ιδιότητες, όπως αυτής του μεγάλου χρόνου εκτέλεσης. Αναλυτική μελέτη 

αυτού του προβλήματος αλλά και τρόποι αντιμετώπισής του αναφέρονται στο κεφάλαιο 

IR-drop analysis. 

Οι Fast-SPICE προσομοιωτές αναπτύχθηκαν αρχικά για να προσφέρουν προσομοιώσεις 

υψηλών επιδόσεων με κύριο προσανατολισμό τα ψηφιακά κυκλώματα. Ωστόσο με τον 

καιρό προστέθηκαν και δυνατότητες προσομοίωσης αναλογικών και mixed-signal 

κυκλωμάτων. Με την πάροδο του χρόνου τα μεγέθη των ψηφιακών κυκλωμάτων έγιναν 

πολύ μεγάλα για να μπορέσει το SPICE να αντεπεξέλθει στις απαιτήσεις της 

προσομοίωσης λόγω των περιορισμών που έθεταν οι απαιτήσεις σε μνήμη και 

επεξεργαστική ισχύ.  
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Η στροφή προς τους Fast-SPICE προσομοιωτές ξεκίνησε με την διαπίστωση ότι μπορεί να 

επιτευχθεί επιτάχυνση της διαδικασίας προσομοίωσης με εκμετάλλευση των ιδιαίτερων 

χαρακτηριστικών των ψηφιακών κυκλωμάτων. Εκείνη την περίοδο, μέσα στην δεκαετία 

του 80, η τεχνολογία είχε φτάσει τα επίπεδα του ενός μικρού (1000 νανόμετρα) για το 

μήκος της πύλης ενός τρανζίστορ. Σε αυτά τα επίπεδα ο χρόνος διάδοσης του σήματος 

μέσα από την πύλη ήταν ο κύριος παράγοντας που χαρακτήριζε την συμπεριφορά του 

κυκλώματος σε αντίθεση με, για παράδειγμα, την καθυστέρηση στις γραμμές διασύνδεσης. 

Η βασική λειτουργικότητα σε prelayout επίπεδο με ελάχιστη προσθήκη RC 

χαρακτηριστικών στους κόμβους του κυκλώματος για βελτίωση του υπολογισμού του 

χρονισμού ήταν τα αρχικά 

συστατικά για την κατασκευή των πρώτων Fast-SPICE εφαρμογών. Με μικρές σχετικά 

γραμμές διασύνδεσης και με τάση τροφοδοσίας κοντά στα 5V φαινόμενα όπως σύζευξη 

χωρητικοτήτων στις γραμμές ή πτώση τάσης στο δίκτυο τροφοδοσίας είχαν αμελητέα 

επίδραση στην λειτουργία του κυκλώματος (Μπούντας, 2009).  

Η βασική χρήση για την οποία προοριζόταν τα Fast-SPICE εργαλεία ήταν σε κυκλώματα 

αποτελούμενα από MOS τρανζίστορ, με ελάχιστα RC στοιχεία (αναλογικά με το ποσοστό 

επίδρασης στην συμπεριφορά του κυκλώματος) και σχεδόν μηδενικά φαινόμενα σύζευξης 

μεταξύ στοιχείων και κόμβων. 

Η πρώτη καινοτομία που εφαρμόστηκε για την επιτάχυνση της διαδικασίας 

ήταν η μετατροπή του προσομοιωτή σε event driven, να αναλύει δηλαδή μόνο τα κομμάτια 

του κυκλώματος στα οποία παρουσιάζεται κάποια δραστηριότητα και για όσο χρονικό 

διάστημα αυτή διαρκεί. Με αυτόν τον τρόπο επιτυγχάνεται σημαντική μείωση των 

αναλυόμενων στοιχείων αφού εξετάζονται μόνο αυτά που βρίσκονται στο κομμάτι του 

κυκλώματος που αναλύεται με σημαντικό όφελος τόσο σε χρόνο εκτέλεσης όσο και σε 

χώρο μνήμης για την προσομοίωση. Για να γίνει αυτό απαιτείται ανάλυση του 

κυκλώματος και 

εντοπισμός των εξαρτήσεων σε τοπικό επίπεδο. Με αυτόν τον τρόπο επιτυγχάνεται να 

αναλύεται μόνο το κομμάτι εκείνο του κυκλώματος που δραστηριοποιείται από μια 

μεταβολή της τάσης ενός κόμβου πάνω από ένα όριο (threshold). Όσο μεγαλύτερο είναι 

αυτό το όριο τόσο μεγαλύτερη είναι και η ταχύτητα προσομοίωσης με αντίστοιχο όμως 

αντίκτυπο στην ακρίβεια των αποτελεσμάτων. Με αυτήν την διαδικασία επιτυγχάνεται 

περιορισμός του 
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μεγέθους του κυκλώματος που αναλύεται, έτσι ώστε να περιλαμβάνει μόνο τα κομμάτια 

που είναι ενεργά. Το κέρδος σε μείωση πολυπλοκότητας είναι πολύ μεγάλο αν αναλογιστεί 

κανείς ότι η δραστηριότητα σε ένα ψηφιακό κύκλωμα είναι σχετικά συγκεντρωμένη τόσο 

σε χώρο όσο και χρόνο, κάτι που συνεπάγεται υλοποίηση ενός πολύ μικρότερου πίνακα 

προς επίλυση σε  

Μια δεύτερη πρωτοτυπία ήταν ο προχαρακτηρισμός για κάθε MOS τρανζίστορ με 

υπολογισμό των σχετικών αναλυτικών συναρτήσεων και αποθήκευση των φορτίων, 

ρευμάτων και χωρητικοτήτων που προέκυπταν σε πίνακες. Έτσι για την υλοποίηση αυτής 

της προσέγγισης οι ζητούμενες τιμές εξάγονται είτε ως έχουν είτε τροποποιούνται χωρίς 

να απαιτείται επανυπολογισμός τους. 

Βασιζόμενα σε αυτές τις τεχνικές οι Fast-SPICE εφαρμογές αποτελούσαν την πιο 

αξιόπιστη λύση για περισσότερο από μια 15ετία και μοναδική εναλλακτική λύση απέναντι 

στο SPICE. Όλες οι μεγάλες εταιρίες παραγωγής εργαλείων CAD έχουν και από μια 

πρόταση σε αυτή την κατηγορία. 
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3. Συμπεράσματα 

 

Η χρήση των εξομοιωτών έχει γίνει αναπόσπαστο κομμάτι τόσο της πρακτικής όσο και της 

έρευνας σε πολλά και διαφορετικά επιστημονικά πεδία. Μάλιστα, η εξέλιξή τους είναι 

τέτοια που τους καθιστά απαραίτητους για τη μελέτη συστημάτων και φαινομένων. 

Τα πλεονεκτήματα που εισάγονται από τη χρήση των προσομοιωτών είναι άπειρα. Η 

αναπαράσταση και μόνο φαινομένων και συστημάτων εκεί όπου δεν είναι δυνατή η 

φυσική παρουσία τους είναι αρκετή ώστε να τους καθιερώσει ως ένα απαραίτητο και 

ιδιαίτερα χρήσιμο εργαλείο μελέτης.  

Στον τομέα των αναλογικών και ψηφιακών κυκλωμάτων η χρήση των προσομοιωτών είναι 

σχεδόν απαραίτητη καθώς πρόκειται για συστήματα ιδιαίτερα μικρού μεγέθους που είναι 

σχεδόν αδύνατο να μελετηθούν με άλλο τρόπο. Για τον παραπάνω λόγο έχει δημιουργηθεί 

σειρά λογισμικών που έχουν ως στόχο να εξυπηρετήσουν την έρευνα αλλά και την 

παραγωγή στη δημιουργία βέλτιστων συστημάτων με άριστες επιδόσεις και ελάχιστες 

απώλειες. Ο χρήστης, είναι πλέον σε θέση να επιλέξει από μία μεγάλη γκάμα λογισμικών 

αυτό που αρμόζει καλύτερα στις απαιτήσεις του.   
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